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ABSTRACT 

 

 

DETERMING THE EFFICACY OF POLOXAMER 188 (P188) IN MENISCAL DAMAGE PREVENTION 

 

 

Meniscal injuries compose 15% of all knee injuries, most often sports-related.  Due to 

the ŵeŶisĐus’s aǀasĐulaƌ Ŷatuƌe, healiŶg is diffiĐult aŶd iŶjuƌǇ ofteŶ ƌesults iŶ a paƌtial 

meniscectomy.  Research has shown meniscectomies drastically decrease contact area between 

the femur and tibia and increase strains experienced by the meniscus.  This additional strain 

predisposes the knee to developing post-traumatic osteoarthritis.  Poloxamer 188 (P188) is a 

non-ionic, amphillic surfactant that may have the ability to prevent cell death through selective 

insertion into the cell membrane.  This in turn may prevent damaged cell signaling and reduce 

overall tissue degradation.  While P188 has been studied and shown promise in mitigating cell 

death in cartilage, the effects of P188 on the meniscus are unknown.  To investigate the effects 

of P188 on the meniscus, the goals of this project were to: 1) create a user friendly graphical 

user interface for a custom bioreactor capable of displacement control for precise loading of 

meniscal explants to physiological and supraphysiological strains; 2) determine the efficacy of 

P188 in mitigating meniscal tissue damage through cell viability, mechanical data and 

histological analysis. 
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CHAPTER 1: INTRODUCTION 

 

 

1.1 Knee Joint Gross Anatomy 

Acting as a modified hinge, the knee is the largest joint in the body.  It is comprised of the 

femorotibial joint and the patellofemoral joint.  The patellofemoral joint consists of the 

articulation between the patella and femoral trochlea and provides knee stability.  The 

attachment of the quadriceps to the patella increases the moment arm and reduces the 

necessary force for knee extension [1,5].  The focus of this study lies within the femorotibial 

joint, in which the femur articulates with the tibia.  The distal part of the femur consists of two 

rounded condyles, which interact with the mostly flat tibial plateau [2].  The basic components 

of the femorotibial joint can be seen in the image below (Figure 1.1). 

 

 

Figure 1.1. A) Anterior view of human knee B) Superior view of human knee 

Images from: http://www.leadingmd.com/patientEd/meniscus/overview.asp 

A 

B 
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Two wedge shaped menisci, lateral and medial, ease this incongruity in shape improving 

joint contact.  Semicircular in shape, the medial meniscus has a wider posterior horn than 

anterior horn.  The anterior and posterior horns are attached to the tibial plateau by insertional 

ligaments.  The anterior horn attaches to the intercondylar fossa in front of the anterior 

cruciate ligament (ACL) and the posterior fibers of the anterior horn meld with the transverse 

intermensical ligament.  This ligament connects the anterior horns of the lateral and medial 

meniscus.  The posterior horn of the medial meniscus is anchored to the posterior intercondylar 

fossa of the tibia between the posterior insertional ligament of the lateral mensicus and the 

posterior cruciate ligament (PCL).  Marginally, the medial meniscus is connected to the joint 

capsule along its entire length.  Midway the meniscus blends with the deep medial collateral 

ligament fastening it to both the femur and tibia [1]. 

The lateral meniscus is circular in form and overlays a larger portion of the tibial plateau 

compared to the medial meniscus.  Unlike the medial meniscus the anterior and posterior 

horns of the lateral meniscus are similar in width.  The anterior insertional ligament of the 

lateral meniscus embeds into the intercondylar fossa of the tibia and partially blends with the 

ACL [3,4].  The posterior horn of the lateral meniscus is more complex. It attaches behind the 

lateral intercondylar eminence and in front of the posterior insertion of the medial meniscus.  

However, in some instances the posterior insertional ligament splits and attaches to the 

intercondylar fossa of the medial femoral condyle.  The insertional ligaments are known as the 

meniscofemoral ligaments and depending on the location of insertion into the femoral condyle 

are known as the ligament of Humphrey, anterior to PCL, or Wrisberg, posterior to PCL [1,4,6].  

According to Kohn and Moreno, 76% of the knees examined had the Wrisberg ligament and 
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37% had the Humphrey ligament present in at least one knee.  The percentage of these 

ligaments occurring in both the right and left knee were considerably lower, 57% of donors had 

the Wrisberg ligament present and 26% had the Humphrey ligament present [3].  Marginally, 

the lateral meniscus is loosely attached to the joint capsule.  Unlike the medial meniscus, the 

lateral meniscus does not attach to a ligament at its midway point, allowing the lateral 

meniscus greater translation [1].  

Other major structures within the knee joint include the cruciate and collateral ligaments.  

There are two cruciate ligaments, the anterior cruciate ligament (ACL) and posterior cruciate 

ligament (PCL), which as the name suggests form a cross.  The ACL is anchored to the posterior 

of the medial surface of the lateral condyle and travels down to the tibia to attach in front of 

and lateral to the medial tibial spine.  Its primary purpose is to restrict anterior translation of 

the tibia on the femur.  Secondary responsibilities also include limiting internal rotation, varus, 

valgus and hyperextension.  The PCL attaches to the lateral surface of the medial condyle and 

inserts into the tibia in the depression between plateaus.  Its principal function is to prevent 

posterior translation of the tibia on the femur, but also regulates varus, valgus and external 

rotation [1]. 

 The collateral ligaments run vertically on the medial and lateral sides of the knee.  The 

medial collateral ligament (MCL) begins at the medial femoral epicondyle and extends downs to 

the tibia.  It resists valgus rotation, external rotation and straight medial and lateral translation 

of the tibia.  From a fovea posterior to the lateral epicondyle, the lateral collateral ligament 

(LCL) extends down to the fibular head with its primary function being resistance to varus 

motion[1].  
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1.2 Meniscus Structure and Function 

The principal components of the extracellular matrix (ECM) of the meniscus are water, 

collagen, proteoglycans and glycoproteins.  The meniscus is largely hydrated containing 

approximately 74% water [7].  Of the dry weight, collagen makes up 75%, proteoglycans 17% 

and glycoproteins and elastin less than 1%.  Type I collagen is most prevalent, but Type II, III, V 

and VI are also found throughout the meniscus [8]. 

Petersen and Tillman found there were three distinct layers of collagen using scanning 

electron microscopy [9].  On the tibial and femoral surfaces, there is a thin superficial layer 

which consists of a mesh of fine collagen fibrils.  Beneath this on both the tibial and femoral 

faces there is a lamellar layer.  This layer is approximately 150-200 um thick and is comprised of 

small lamellar bundles that have a random orientation on the tibial surface and a radial 

orientation on the femoral surface.  In the central main layer, larger bundles of collagen fibrils 

run circumferentially giving the meniscus the ability to transfer loads through the joint.  While 

the laƌge ŵajoƌitǇ of fiďeƌs ƌuŶ ĐiƌĐuŵfeƌeŶtiallǇ, theƌe aƌe a feǁ ƌadial ͞tie͟ fiďeƌs iŶteƌǁoǀeŶ 

ǁithiŶ the ĐiƌĐuŵfeƌeŶtial fiďeƌ ďuŶdles.  These ͞tie͟ fiďeƌs supplǇ stƌuĐtuƌal suppoƌt aŶd 

prevent longitudinal splitting [9,10].  While studying bovine meniscus Cheung found regional 

distributions of type I and II collagen fibers.  The outer two-thirds consisted primarily of type I 

collagen while the inner one third was largely made of type II collagen.  Trace amounts of type 

III and V collagen were present as well [11].   

Proteoglycans consist of a protein backbone to which glycosaminoglycan (GAGs) chains are 

covalently bonded.  GAGs are negatively charged and associate with sodium ions which can in 
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turn associate with water.  The presence of water in the meniscus confers its compressive 

abilities.  In the human meniscus the percent GAGs are 40% chondroitin 6-sulfate, 10-20% 

chondroitin 4-sulfate, 20-30% dermatan sulfate and 15% keratin sulfate.  Two types of 

proteoglycans have been documented in the meniscus.  Aggrecan, a large proteoglycan, binds 

to hyaluronic acid creating proteoglycan aggregates.  These aggregates are formed when 

several proteoglycans bind to hyaluronic acid with the help of link proteins.  The other type of 

proteoglycan is small and non-aggregating with only one or two chains of dermatan or 

chondroitin sulfate attached [10,12,13]. 

Also present in the ECM are glycoproteins.  Several of these serve as an adhesive, binding to 

other matrix molecules or cells.  They serve an important function acting as molecular glue and 

providing methods for cell migration and attachment.  These include type VI collagen, 

fibronectin, and thrombospondin [13].  Small concentrations of elastin have been detected in 

the meniscus as well.  However, its exact function is yet to be determined [8]. 

The menisci are key to a properly functioning knee joint as they deform and move with 

flexion and extension of the knee allowing the tibia and femur to remain in congruity.  From 0-

120 degrees of flexion, anterior-posterior translation of the medial meniscus is approximately 5 

mm while the lateral meniscus experiences twice that with approximately 11 mm of 

movement.  The medial meniscus periphery blends with the MCL and is therefore more 

confined.  In rotation the lateral meniscus has more freedom to move while the medial 

meniscus is again restricted by the MCL.  This leads to an increased risk of tear in the medial 

meniscus[10]. 
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The meniscus is a biphasic viscoelastic material due to its fluid and solid phase.  The fluid 

phase makes up 74% of the wet weight and is composed of water and interstitial electrolytes.  

Collagen, proteoglycans and other noncollagenous proteins form the solid phase consisting of 

26% of the wet weight.  This solid phase acts as a permeable fiber-reinforced composite [19].  

As the joint is loaded, a tensile or hoop stress develops in the circumferentially oriented 

collagen fibers.  The meniscal horn attachments prevent the meniscus from being extruded 

from the joint as load increases.  The importance of this hoop stress has been demonstrated in 

various studies [19,20,22].  Full radial tears, which disrupt the circumferential fiber 

arrangement, lead to loss of tensile strength and equate to a total meniscectomy in load 

transfer [20,22].  The mechanical response can be separated into two phases, the initial elastic 

response and the time-dependent fluid flow. As the knee joint is loaded, the solid matrix and 

interstitial fluid of the meniscus are compressed increasing its hydrostatic pressure.  After the 

initial compression, stress relaxation occurs as the fluid flows out of the meniscus lowering the 

hydrostatic pressure.  Fluid flow persists until pressure equilibrium is achieved [21]. 

Besides its biphasic properties, the meniscus is also transversely isotropic.  Leslie et al 

performed a study to evaluate the response of the meniscus in the axial, radial and 

circumferential directions in unconfined compression [23].  The tissue showed higher stiffness 

values under axial compression compared to loads applied in the radial and circumferential 

diƌeĐtioŶs.  At high stƌaiŶ ƌates ;ϴϬ%Ϳ, the YouŶg’s ŵodulus iŶ the aǆial diƌeĐtioŶ ǁas Ϯϵϵ MPa, 

ǁhile the ƌadial aŶd ĐiƌĐuŵfeƌeŶtial diƌeĐtioŶs shoǁed Ŷo sigŶifiĐaŶt diffeƌeŶĐes ǁith ŵodulus’ 

of 287 and 288 MPa respectively [23].  Further studies have explored regional variation within 

the menisci.  A study by Jones et al focused on hoop strains in the medial meniscus under 
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compression.  The anterior and center portions had similar mean strains of 2.86% and 2.65% 

respectively, while the posterior section displayed significantly lower strains with a mean of 

1.54% [22].  A 2009 study by Bursac et al further elicited the regional variation in the human 

meniscus [58].  The medial meniscus showed significantly higher compressive stiffness in the 

anterior segment compared to the central and posterior segments.  The anterior region of the 

medial meniscus was also significantly stiffer than the anterior region of the lateral meniscus.  

The lateral meniscus showed no significant differences in regional stiffness values, but there 

was a general increase moving from the anterior to posterior segments.  This difference in 

modulus values positively correlated with GAG content.  The anterior segment of the medial 

meniscus had higher GAG content than the central and posterior segments as well as the 

anterior segment of the lateral meniscus.  Higher GAG content produces larger swelling 

pressures which better allow the menisci to resist compression. 

The menisci serve several functional roles including load bearing, shock absorption, joint 

stability and proprioception [4].  The meniscus was originally thought to be a vestigial organ 

which served no real purpose.  Until 1948 when Fairbank demonstrated the degenerative 

effects of a meniscectomy, it was common practice to remove the entire structure in the event 

of injury [14].  Depending on degree of flexion of the knee, 50-85% of the load is transferred 

through the menisci [ϭϬ].  MeŶisĐeĐtoŵǇ gƌeatlǇ deĐƌeases the joiŶt’s ability to transmit loads 

as the contact area is decreased and the contact force increases.  Kurosawa et al showed that 

after total meniscectomy the contact area was reduced by a third to half.  This resulted in 2-3 

times increased contact forces [15].  Lee et al demonstrated the effects of partial and total 

medial meniscectomy.  With a decreased contact area of 20% (50% meniscectomy), the peak 
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contact stress increased by 43% while a decreased contact area of 54% (total meniscectomy) 

resulted in a peak contact stress increase of 136% [16]. 

 Hoshino and Wallace examined the impact absorbing ability of the knee joint by 

subsequently removing soft tissue and subchondral bone [47].  Removing only the meniscus 

increased the mean peak force within the joint by 20%.  Voloshin and Wosk performed a study 

ŵeasuƌiŶg shoĐk aďsoƌptioŶ usiŶg aĐĐeleƌoŵeteƌs aŶd Đlaiŵed a ϮϬ% ƌeduĐtioŶ iŶ the joiŶt’s 

shock absorption ability with a total meniscectomy [17].  However, Andrews et al. dispute 

VoloshiŶ aŶd Wosk’s fiŶdiŶgs, statiŶg the menisci may not have caused the decrease in shock 

absorption as painful knees with intact menisci also showed the same loss of shock absorption 

[18]. 

 The meniscus is also a well-known secondary stabilizer in the knee joint.  Primary 

resistance to anterior tibial translation is provided by the ACL.  A 1982 study by Levy et al 

deŵoŶstƌated the ŵeŶisĐus’s seĐoŶdaƌǇ ƌole iŶ joiŶt staďilizatioŶ.  IŶ kŶees that had uŶdeƌgoŶe 

a total meniscectomy, but still had an intact ACL there was no change in anterior-posterior 

displacement compared to an intact knee.  However, after sectioning of the ACL, the medial 

meniscus resisted anterior-posterior displacement significantly compared to a knee lacking 

both the medial meniscus and ACL [24].  A study by Shoemaker and Markolf reinforced these 

results and highlighted the particular importance of the posterior horn of the medial meniscus 

in resisting anterior tibial force [25].  A later study by Levy et al focused on the effect of lateral 

meniscectomy on anterior and posterior translation on the knee.   Results indicated that the 

lateral meniscectomy did not provide the same wedging effect and did not prevent anterior 

translation in the ACL deficient knee [26].  A more recent study by Musahl et al indicated that 
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while the lateral meniscus may not play a part in resisting anterior-posterior displacement from 

anteriorly directed loads on the tibia, it may resist anterior tibial translation during a pivot 

movement.  During a pivot, the knee undergoes valgus and rotary loads [27]. 

 It has also been suggested that the meniscus may play some role in proprioception.  

Aagaard proposed this as a possibility due to the neurophysiology of meniscal tissue [21].  The 

nerve branches are found in the same outer third region of the meniscus as the blood supply 

with the horns containing the largest number of fibers.  Three different types of nerve endings 

have been recognized within meniscal tissue: Pacini corpuscles, Ruffini endings, and Golgi 

tendon organs.  The existence of these mechanoreceptors in the menisci suggest an essential 

role in nerve transmission.  Aagaard suggests that neural information from these 

mechanoreceptors may moderate the anterior-posterior translation of the femoral condyle on 

the tibial plateau [21]. 

1.3 Cellularity 

In the early formation stage, meniscus tissue consists mostly of rounded cells compacted 

together [29].  With maturation comes cell differentiation.  Three distinct types of cells have 

thus far been identified in a fully mature meniscus.  These are superficial zone cells, round or 

oval-shaped fibrochondrocytes and fibroblast-like cells.  The superficial zone cells lie just below 

the surface of the tissue and have a fusiform shape with no cytoplasmic projections.  

Fibrochondrocytes, round or oval-shaped, are found in the middle and inner portions of the 

meniscus and have a pericellular matrix.  Located in the outer third of the meniscus, fibroblast-

like cells have a fusiform shape and lack a pericellular matrix.  Moving through the meniscus, 
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intermediates between distinct cell types are found as shown in figure 2.  Generally, the cells in 

the outer margin are more similar to fibroblasts with abundant cell processes.  Moving inward 

the cells have less cell processes and tend to be more chondrocyte like.  These cells are 

responsible for producing the collagen abundant extracellular matrix.  This distribution of cells 

divides the meniscus into two sections.  The fibroblast-like cells produce collagen I in the outer 

third, while the fibrochondrocytes produce slightly more collagen II than collagen I in the inner 

two thirds.  The cell type also dictates the amount of GAG produced.  Several studies have 

shown more GAG to be present in the inner two thirds than the outer portion of the meniscus 

which is consistent with its cellular composition [28, 29, 30]. 

1.4 Vasculature and Healing 

In 1936, King was the first to notice the healing capability of the menisci and stated that for 

any healing to occur the lesion must be in contact with the blood supply [31].  Branches from 

the lateral medial genicular arteries form a perimeniscal capillary plexus within the synovial and 

capsular tissues of the knee joint, which provides the vascular supply to the margins of the 

menisci.  During the early stages of development, the meniscus is completely vascularized.  

However, postnatally the inner region becomes avascular.  It has been postulated that 

avascularity is produced by weight-bearing and knee motion.  The amount of vascularization 

varies between the medial and lateral meniscus.  The medial meniscus is typically 10-30% 

vascularized while the lateral meniscus has 10-25 % vascularization.  Both the horn attachments 

of the medial and lateral meniscus have an excellent blood supply [32].  Current research 

suggests the inner region of the meniscus is nourished through diffusion [10]. 
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 In order for tissue to heal, it must be in contact with the blood supply.  The meniscus 

has been divided into three regions based on vascular supply: red, red-white, and white.  The 

red region has a considerable vascular supply, while the white zone is completely avascular.  

The red-white zone is the junction of the two areas.  Tears in the red-red zone have great 

potential for healing, whereas tears in the white-white zone have virtually no healing potential.  

Healing potential in the red-white zone is dependent on the type of tear.  Clinically when tears 

are in the red-red zone, tears are sutured and often heal sufficiently on their own.  

Unfortunately, the majority of tears occur in the inner region and require at least a partial 

meniscectomy [21]. 

 

Figure 1.2. The outer third of the meniscus is vascularized with fibroblast-like cells.  Moving towards the interior, 

the meniscus becomes avascular with chondrocyte-like cells. Image from: Makris, 2011 [8] 

 Osteoarthƌitis has ďeeŶ defiŶed as ͞a foƌŵ of ĐhƌoŶiĐ aƌthƌitis ĐhaƌaĐteƌized ďǇ Đaƌtilage 

degradation, mildly inflammatory or noninflammatory joint fluid, joint-space narrowing, and 

ďoŶe sĐleƌosis.͟  Post tƌauŵatiĐ osteoaƌthƌitis has ďeeŶ liŶked to tƌauŵatiĐ oǀeƌloading which 

may result in anterior cruciate ligament (ACL) and meniscus tears [55-57].  These studies have 

demonstrated degradation of proteoglycans and collagen, crucial components of the 
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extracellular matrix, after knee joint injury.  Radin et al demonstrated that the menisci protect 

the articular cartilage, preventing stress concentrations and the degradation of the cartilage 

[34].  In 1977, Cox and Cordell used a canine model to demonstrate that damage to the 

meniscus caused corresponding degradation in the articular cartilage of the knee [35].  These 

studies illustrate the importance of a healthy meniscus to the overall health of the knee joint. 

1.5 Poloxamer 188 

During normal physiological events, many cells undergo various forces that may cause the 

plasma membrane to rupture [38].  If membrane integrity is not restored, loss of the 

cytoplasmic  contents into the extracellular space or the rapid of influx of calcium will render 

the cell functionless [48].  It is therefore vital that these cells have the ability to reseal the 

plasma membrane [38,49].  While the exact mechanism in the repair process is still unknown, 

several studies have elicited certain aspects of the process [36-38].  If the disruption is small 

and occurs in a lipid bilayer composed only of polar lipids, the repair process will occur 

automatically through thermodynamics [36].  However, this is not the case for most cells.  More 

substantial ruptures will require an active process: the formation of a membrane patch [36].  

Once the plasma membraŶe’s iŶtegƌitǇ has ďeeŶ Đoŵpƌoŵised, a ƌush of eǆtƌaĐellulaƌ ĐalĐiuŵ 

will signal to other vesicles within in the cell to migrate to the rupture location and fuse 

together creating a membrane patch [38].  Once the patch has formed, it fuses to the 

membrane through a process not yet fully understood. Besides restoration of the plasma 

ŵeŵďƌaŶe, the Đell’s ĐǇotoskeletoŶ ŵust also ƌeďuild its iŶitial aƌĐhiteĐtuƌe.  The ŵeŵďƌaŶe 

patĐh is a teŵpoƌaƌǇ fiǆ that ǁhile pƌoloŶgiŶg the Đell’s life, does Ŷot ƌestoƌe Ŷoƌmal cell 

function.  Several theories have been proposed on how the patch is replaced with a whole, 
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continuous, and functional plasma membrane [38].  One theory suggests membrane diffusion 

from the neighboring region as the mechanism of action.  Another suggests a new plasma 

membrane is formed beneath the patch which is then shed.  Though the exact mechanism is 

Ŷot ǁell uŶdeƌstood, it has ĐleaƌlǇ ďeeŶ shoǁŶ this ƌepaiƌ pƌoĐess is ĐƌuĐial to the Đell’s suƌǀiǀal.  

Figure 1.3 illustrates this process in healthy muscle cells. 

 

Figure 1.3. Membrane patch repair process in healthy muscle. 

 Calcium influx signals intracellular vesicles to membrane rupture  

where the vesicles fuse together to create membrane patch. 

Image from: Han, 2011 [50] 

While this mechanism works for normal physiological damage, extensive injury to the cell 

membrane caused by trauma or disease cannot always be fixed without external intervention.  

This has led to an investigation into materials that may be able to aid in the plasma membrane 

resealing process. Mild surfactants have shown some promise in this area due to their 

amphiphilic properties.  Poloxamer 188 (P188) is a triblock copolymer with the structure of 

POE-POP-POE with POE representing poly(oxyethylene) and POP poly(oxypropylene) with a 

molecular weight of 8400 daltons.  The POP center provide a hydrophobic core while the 
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flanking POE chains create the hydrophilic ends giving P188 the ideal structure to insert into 

lipid bilayers [39]. 

 Investigations by Maskarinec et al utilized a lipid monolayer to analyze P188 insertion into 

the cell membrane.  They used dipalmitoylphosphatidylcholine (DPPC) and 

dipalmitoylphosphatidylglycerol (DPPG) molecules to form two separate monolayers.  It was 

found that in both monolayers P188 would not insert into the monolayer until surface pressure 

was lowered to 22 mN/m or less.  Surface pressure was then increased until P188 was 

͞sƋueezed out͟ of the filŵ.  Pƌessuƌes laƌgeƌ thaŶ Ϯϱ ŵN/ŵ ǁeƌe ƌeƋuiƌed to eliŵiŶate the 

poloxamer in DPPC and larger than 28 mN/m for DPPG.  The typical surface pressure for a 

normal bilayer is approximately 30 mN/m.  As P188 does not insert into the monolayer until 

surface pressures are lowered to 22 mN/m, this suggests that P188 selectively inserts into 

damaged membrane.  Because the elimination pressure is higher than the insertional pressure, 

this indicates that as the cell membrane heals, P188 will be released from the membrane [40].  

This process can be seen in the figure below (Figure 1.4). 

 

Figure 1.4. After damage to cell membrane, P188 will insert into lipid bilayer preserving cell integrity until the 

membrane is able to heal.  Once healed, the cell will expel P188 into extracellular space. 

Image from: http://www.maroonbiotech.com/research/sct.html 
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P188 has shown promise in sealing electropermeablized skeletal muscle membranes [41], 

saving neuronal cells that have undergone mechanical insult [42], and reducing cell death in 

knee and ankle cartilage [43,44,45].  Phillips et al examined the effect of P188 on chondral 

explants from bovine forelegs [39].  Explants were impacted with a load of 707 N (~25 MPa) and 

then incubated in media with or without P188.  Cell viability was examined at two time points, 

1 and 24 hours after impact, and within three zones, superficial, middle and deep.  In the 

superficial zone, explants that were not treated with P188 had a 45% reduction in live cells at 1 

hour, while after 24 hours they had 62% reduction in live cells.  The middle zone of the 

untreated explants exhibited no differences after 1 hour, but had a 28% reduction in live cells 

after 24 hours.  The deep zone showed no differences at either time point.  Baars et al 

performed a similar study on bovine chondral explants and found that after 4 and 7 days post-

impact, P188 reduced the percentage of cells with DNA fragmentation by 45% [43].  An in vivo 

rabbit study by Isaac et al examined the effect of P188 on knee cartilage in an unconfined 

impact model at 4 days and 6 weeks [51].  After 6 weeks, there was a significant higher viable 

cell density in the P188 treated limb compared to the untreated limb. 

The effects of P188 have also been examined in human ankle cartilage [45].  An ex vivo 

study was performed using 8 mm cartilage plugs from normal human tali consisting of a 4 mm 

impacted core and the adjacent ring.  P188 was applied for 48 hours after impact and cartilage 

explants were examined at 0, 2, 7 and 14 days after injury.  The P188 treated explants showed 

significant reduced cell death in both the impacted core and the adjacent ring compared to the 

impacted, untreated group.  There was also a significant reduction in the radial expansion of 
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apoptosis/necrosis into the adjacent ring for the first 7 days.  This suggests that the healed cells 

are healthy and functioning properly. 

Currently there has been only one known study that has examined the impact of P188 on 

the meniscus. Coatney et al performed an in vivo 6 week study on Giant Flemish rabbits.  While 

no significant changes in mechanics were detected, significantly lower GAG coverage was 

detected in injured and untreated limbs compared to controls and injured and treated limbs 

[46].  Further investigation is required to determine the direct effect of P188 on the meniscus 

versus an in vivo situation where the effect could be direct or indirect.  

1.6 Hypotheses and Specific Aims 

Although clinically characterized by degradation of articular cartilage, osteoarthritis has 

been associated with meniscal injuries [4,8,21].  Traumatic overloading may result in tearing of 

the anterior cruciate ligament (ACL) and/or the meniscus.  Tearing of the meniscus primarily 

results in partial meniscectomy due to its lack of healing capacity because of its avascular 

nature [21].  Previous studies have focused on meniscal injury due to traumatic loading both in 

vivo and in vitro [52-54].   Besides gross tissue damage, large impacts and consistent 

overloading due to partial meniscectomy may also have deleterious effects at the cellular level.  

Glycosaminoglycans (GAGs) and collagen are the primary components of meniscal extracellular 

matrix (ECM).  Without healthy functioning cells, the ECM cannot be produced.  Several studies 

have shown evidence of degradation of the ECM after knee joint injury [55-57].  As the ECM 

changes, the material properties of the meniscus may be modified, thereby changing knee joint 

loading and leading to joint disease such as osteoarthritis.  P188 has shown promise in resealing 
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injured cell membranes in cartilage, neurons, and skeletal muscle [39,41-45], but its effect on 

meniscal tissue is unknown.  Therefore, the objective of this study is to examine the effect of 

P188 on menisci that have undergone in vitro physiological and supraphysiological loads.  The 

working hypothesis for this study is the application of P188 will mitigate the effects of 

overloading meniscal tissue.  To test this hypothesis the following aim will be pursued. 

I. To establish the efficacy of P188 in mitigating the effects of overloading meniscal 

tissue.  Explants will undergo unconfined compression to 10% and 20% strains at a 

frequency of 1 Hz, to simulate walking, for 1 hour for 1 or 7 days.  Cell viability and 

histological analysis will be utilized to investigate the effects of P188. 

Hypothesis: 

P188 has been shown to successfully reduce cell death after cell damage in cartilage 

as well as maintain GAG coverage in menisci caused by mechanical overloading.  We 

hypothesize that in the presence of P188, the degradative effects of mechanical 

overloading on the meniscus will be mitigated. 
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CHAPTER 2: DEVELOPMENT OF BIOREACTOR GRAPHICAL USER INTERFACE 

 

 

2.1 Introduction 

Under normal physiological conditions, the meniscus undergoes high levels of 

mechanical stress, which can affect metabolic activity and disrupt meniscal cells plasma 

membranes [1-4].  Cellular repair is crucial to keep tissue functioning.  Small ruptures in the cell 

membrane can be repaired through natural processes within the body [4-6].  During traumatic 

events, high levels of mechanical stress can create cellular membrane damage the body cannot 

sufficiently repair, leading researchers to explore other avenues for repair.  Mimicking these 

physiological and traumatic loads in vitro using tissue explants is an effective method to 

observe the results of high mechanical stress on the meniscus and allow investigation of repair 

methods.  To study these effects, in vivo conditions need to be simulated as closely as possible. 

Depending on the nature of the study, several different approaches exist for recreating 

the in vivo environment.  These devices, typically called bioreactors, can be used to recreate 

physiological loads on tissues or cells in the lab.  Shear, compression, tension, and biaxial 

deǀiĐes aƌe aǀailaďle ĐoŵŵeƌĐiallǇ [ϴ].  This pƌojeĐt’s goal is to Đƌeate a LaďVIEW dƌiǀeŶ deǀiĐe 

to load meniscal tissue to physiological and supraphysiological loads as seen in healthy and 

disease states. 

There are several necessary qualifications a bioreactor must meet in order to ensure 

successful testing.  When mimicking the in vivo environment, great care must be taken to 

ensure explants remain sterile throughout the procedure.  This is most readily accomplished by 
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G 

ensuring that all equipment that comes into contact with the explants can be easily sterilized 

either by means of an autoclave or alcohol.  To create the correct biochemical environment, 

culture media and certain additives are utilized.  Constant incubation (37oC, 5% CO2) is also 

required, which calls for a bioreactor made of materials that can withstand warm, humid 

conditions for days at a time.  This was achieved using a previously validated bioreactor (Figure 

2.1) [7]. 

 

Figure 2.1. Side view of bioreactor. A) Animatics SmartMotor SM1720, B) UltraMotion Bug linear actuator, C) 

Enclosed well plate and plunger, D) Interface load cell, E) Honeywell optical encoder, F) plunger, G) well plate 

 

A 

B 

C 

D 

E 
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The system consists of a belt-driven linear actuator (Ultra Motion Bug) driven by a 

motor (SM1720) (Ultramotion, Mattituck, NY).  The actuator has a stroke length of 8.128 cm 

with a maximum force of 2225 N and maximum speed of 11.684 cm/sec.  When built in 2003, 

the SmartMotor Interface(SMI), using programs written with SMI programming language, was 

utilized to send motor commands.  However, this method of motor control has become 

outdated and was not user friendly.  Therefore the primary purpose of this study was to update 

motor control by creating a user friendly graphical user interface (GUI) in LabVIEW.    LabVIEW 

utilizes a front panel (user interface) and a block diagram (code).  The user interface allows the 

user to change specifications for motor control without changing the code.  The new program 

will combine manual and automatic cyclic displacements as well as control of the load cell 

within one easy to use graphical user interface.   

2.2 Design of LabVIEW program 

Several requirements must be met by the LabVIEW GUI.  It is essential that the user have 

manual control of the bioreactor.  Manual control is necessary to allow the exchange of explant 

groups and to properly position the plunger before starting cyclic displacement.  Automatic 

cyclic displacement is ceŶtƌal to the ďioƌeaĐtoƌ’s puƌpose.  The Ŷuŵďeƌ of ĐǇĐles, fƌeƋueŶĐǇ of 

the cycles and displacement must be easily adjustable.  Data collection and monitoring of load 

cell output and motor position are also required.  These requirements were met with the 

following program. 

LabVIEW programming consists of a front panel and block diagram.  The front panel 

functions as the GUI, while the block diagram contains the graphical source code of the 
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program.  The bioreactor GUI allows the user to control manual and cyclic commands from the 

same simple front panel as seen in figure 2.2.   There are 3 major sections on this panel: 1) 

Manual command, 2) Cyclic displacement command, 3) Load cell output and motor position 

data. 

 

Figure 2.2. Front panel of LabVIEW program. 

Manual control was achieved using an optical encoder (Honeywell, Morris Plains, NJ), 

which converts mechanical rotary motion into digital electrical output (Figure 2.1E).  The motor 

has the capability to follow quadrature signals from an encoder in Mode Follow.  The encoder 

outputs two square waves with channel A leading channel B by 90o counterclockwise with 

continuous electrical travel. This offset allows the encoder to detect clockwise and 

Load Cell 

Motor Position 

3 
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counterclockwise rotation.  It is an incremental rotary encoder with 128 pulses per revolution 

and does not track absolute position.  A source voltage of 5 Vdc and a supply current of 30 mA 

is required with an output voltage of 0.4 Vdc and 2.4 Vdc.  Rotating the encoder 

counterclockwise raises the plunger, while rotating clockwise lowers the plunger.   The manual 

portion of the program is controlled by section 1 of the GUI as seen in figure 2.3.  

 

Figure 2.3. Manual command on front panel. 

In order for any commands to be sent, manual or automatic, the computer must have 

the means to communicate with the device.  VISA (Virtual Instruments Software Architecture) 

provides a simple avenue for communication between the motor and computer.  The VISA 

resource name control shown in Figure 2.3A allows the user to choose the port through which 

the motor and computer will communicate.   LabVIEW has created VISA controls specific to the 

method of communication between the device and computer. The SM1720 motor relies on 

serial communication and thus, a serial VISA control terminal was utilized on the block diagram 

(Figure 2.4).  The serial port is straightforward to configure, allowing easy adjustments to 

termination characters, baud rates, data bits, etc.  An advantage to using the VISA system is the 

D E A 

B 
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program can be operated on several platforms that support LabVIEW as VISA defines its own 

data types.   

 

Figure 2.4. Visa serial port on block diagram. 

The Manual Encoder Speed (Figure 2.3B) regulates the proportion of revolutions 

between the optical encoder and the linear actuator.  As seen in Figure 2.3, it was set at 5 as 

this was found to be the optimum proportion.  This was the highest it could be set without 

causing the belt connecting the motor and actuator to slip, disrupting the smooth linear motion 

of the actuator. The Manual Command play button (Figure 2.3C) turns manual control on and is 

active when the light is green.  The Manual Encoder Command field (Figure 2.3D) allows the 

user to monitor the current code commanding the optical encoder.  The code currently 

displayed shows the motor is in Mode Follow at the highest resolution (MF4) and has a 5:1 ratio 

of revolutions between the encoder and linear actuator.  The large square Manual Encoder 

indicator (Figure 2.3E) turns green when the program is running and red when off.   

The previously used SMI language required several calculations in order to input correct 

displacement and frequency for manual commands as the language communicates using motor 
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counts.  To send a command specifying a displacement (D) of 0.5 mm, a velocity (V) of 1 mm/s 

with an instantaneous acceleration (A), the following would be used: 

MP 

A = 10000 

V = 2512 

D = 1256 

G 

 

This code would then have to be reentered each time the user wished to move the plunger.  

With this GUI, once the manual portion of the program has been activated, the user can 

continually move the plunger up and down as necessary without reentering code.  This is due to 

the while loop (A) enclosing the SMI commands as seen in Figure 2.5.  The commands will be 

continuously sent to the motor until the user authorizes the program to stop.  Besides allowing 

serial port configuration, VISA also provides a user friendly method to read and write 

commands sent to the motor.  VISA Write sends the data to be written to the device.  VISA 

Read reads the data from the device such as current motor position. 

 

Figure 2.5. Manual command on block diagram. 

A 
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Manual command is utilized to move the plunger into position above the explants.  As 

shown in Figure 2.1, the well plate containing the explants and plunger are enclosed with a cap.  

The enclosed system can be easily attached or removed using quick disconnect pins.  When 

attaching the enclosed structure, it is first connected to the load cell via one pin.  The weight of 

the plunger (132.05 grams) serves as the preload.  The manual command program is then 

utilized to lower the actuator to line up with the plunger and connected via another pin.    Once 

the plunger has been attached, the cyclic displacement portion of the program may be put into 

effect as shown in figure 2.6. 

 

Figure 2.6. Cyclic displacement control on the front panel. 

The cyclic displacement section of the program (Figure 2.6) allows the user to easily 

configure the bioreactor to their specifications.  The white boxes are controls and indicate 

values that can be set by the user, while the gray boxes are indicators and are values that are 

reported back to the user.  The previous displacement program using the SMI could only run at 

a frequency of 1 Hz at a specified displacement in millimeters for a specified number of cycles.   
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With this GUI, displacement and time units can be selected easily by the user.  The commands 

can be sent in inches, millimeters or centimeters and seconds, minutes or hours.  Frequency 

and number of cycles can also be easilǇ desigŶated.  The ďioƌeaĐtoƌ’s ĐuƌƌeŶt ĐǇĐle is shoǁŶ iŶ 

the dark gray current cycle indicator box.  To ensure the program is operating on the correct 

time frame, a separate timing loop was included in the program.  A target time can be set and 

when the specified time has elapsed, the green indicator will light up.  Below the target time 

entry, is the run time box which shows the real time elapsed over the course of the program. 

The sampling rate refers to the rate at which the motor position is recorded.  20 Hz was found 

to be the maximum rate at which this could occur.  The limiting factor was the rate at which the 

motor could report position values.  Motor position data is easily saved by specifying a file 

name in the Motor Position file name box.  All data files are saved as text files. 

The commands for the cyclic displacement portion are broken into two sections on the 

block diagram.  The first section (Figure 2.7) initializes the motor (A), calculates displacement, 

velocity, and acceleration (B), and sends commands in the SMI language (C).  Initializing the 

motor requires disabling displacement limits set by the manufacturer, clearing any previous 

errors and setting the PID (Proportional, Integral, Derivative) filter.  Figure 2.7A displays the PID 

settings of KP = 42, KI = 28 and KD = 550 corresponding to the proportional, integral and 

derivative coefficients respecitively.  The settings of the PID filter are used in an algorithm that 

delivers the necessary power required by the motor to keep the shaft on target and to reduce 

vibrations.  The input to the PID control is position error, the desired position minus the actual 

position.  The Proportional parameter is a spring constant and supplies the needed power to 

return the motor shaft to its target position.  The Integral parameter is an opposing force that is 
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a function of time.  This parameter helps the Proportional parameter bring the motor shaft 

back to the target position more accurately.  Without the Integral parameter, the Proportional 

parameter would constantly oscillate around the target position.  The Derivative parameter acts 

as a shock absorber, reducing power as a function of the rate of change of the overall PID 

control output and therefore dampening vibrations.   

Setting the displacement, velocity and acceleration requires many calculations as the 

command must be sent in motor counts.  In Figure 2.7C, the P refers to the absolute position of 

the ŵotoƌ.  EaĐh tiŵe the ŵotoƌ is shut doǁŶ a Ŷeǁ ͞Ϭ͟ positioŶ is defiŶed.  “peĐifiĐallǇ, the 

motoƌ sets the ͞Ϭ͟ positioŶ as the ĐuƌƌeŶt loĐatioŶ of the ŵotoƌ ǁheŶ it is tuƌŶed oŶ.  

Therefore, to start cyclic displacement, the position of the motor must be reported when the 

manual control is switched off.  This is accomplished utilizing VISA Read and Write as shown in 

Figure 2.5.  From the current motor location, the required displacement can be added or 

subtracted to create cyclic movement of the actuator (Figure 2.7B).  For example, the user 

inputs 2 mm as the designated displacement.  2512 motor counts is equivalent to 1 mm.  The 

program multiplies 2 by 2512 to get the required motor counts and first subtracts then adds the 

specified motor counts to the absolute position to create cyclic displacement.  If the user enters 

a positive value for the displacement, the actuator will move down initially.  If a negative value 

is entered, the actuator will move up first.   In Figure 2.7C, the A refers to acceleration.  This is 

given an arbitrary high value to ensure instant acceleration, in this case it was set at 100,000.  

The V (Figure 2.7C) refers to velocity and requires the most complex computation based off the 

useƌ’s fƌeƋueŶĐǇ aŶd displaĐeŵeŶt iŶputs.  The “ŵaƌtMotoƌ uses iŶteƌŶallǇ sĐaled ĐouŶts peƌ 

second as its velocity units and thus requires several multipliers to reach the desired velocity as 
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shown in Figure 2.7B.  The motor uses a 2000 encoder count per revolution. Once the velocity 

has been put in terms of revolutions per second, it can be multiplied by 32,212 scaled encoder 

counts per second/revolution per second yielding a final velocity value that is sent to the 

motor. 

 

Figure 2.7. Cyclic displacement commands on block diagram. 

 The second section of the program (Figure 2.8) performs the specified action 

established by the user and initialized in the first portion of the block diagram.  The external for 

loop (Figure 2.8A) controls the number of times the plunger compresses the explants.  Each 

time the loop runs, the plunger moves up or down.  Therefore, the loop is run twice the 

number of specified cycles in order to complete the requisite number of full cycles.  It was also 

necessary to add a timing function (Figure 2.8C) to the for loop (Figure 2.8A).  Without a timing 

A 
C 

B 
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function, the loop would begin its next cycle immediately after the previous one is finished.  By 

adding a timing function, the loop has been set to run twice during a cycle period, which is 

automatically calculated when the user sets a frequency. Motor position is also recorded to 

ensure the correct displacements are being reached.   Within the for loop is a while loop (Figure 

2.8B) which records motor position.  The sampling rate (Figure 2.6) controls the timing for this 

loop.  For example, when the rate is 20 Hz, then the position is recorded 20 times every second. 

 

Figure 2.8. Cyclic displacement commands on block diagram (2nd section) 

 To ensure correct displacement while the program is running, motor position must be 

monitored.  This was achieved with the addition of a graph monitoring motor position in the 

bottom right corner of the front panel (Figure 2.2).  The y axis represents motor counts and the 

x axis is time.  2512 motor counts correspond to 1 millimeter.  In Figure 2.9, the motor position 

A 

B 
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oscillates between -2015 and -1012, which corresponds to 1003 motor counts or 0.4 mm.   The 

ŵotoƌ ĐouŶts aƌe Ŷegatiǀe as the pluŶgeƌ is loǁeƌed ďeloǁ the ͞Ϭ͟ positioŶ ;Figuƌe 2.9). 

 

Figure 2.9. Motor position graph on front panel. 

The top right section of the front panel controls the load cell.  The graph shows real time 

data as the program is running and automatically adjusts the axes as the load changes.  The y 

axis is load in pounds and the x axis is time (Figure 2.10).  Load cell data is easily saved by 

specifying a file name in the Load Cell file name box.  The load cell communicates with the 

program through a National Instruments (NI) data acquisition chassis (NI cDAQ-9174) with a NI 

USB-9219. 
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Figure 2.10. Load cell graph on front panel. 

  The NI USB-9219, pictured below in figure 2.11, has four channels of universal analog 

input and supplies a USB interface between the load cell and computer.  It can support quarter, 

half-, and full-bridge configurations with built-in current and voltage excitation.  NI-DAQmx is 

LaďVIEW’s latest data aĐƋuisitioŶ dƌiǀeƌ that pƌoǀides a software interface to hardware devices.  

The Measurement and Automation Explorer (MAX) is utilized to access the DAQ assistant, 

which allows the user to create and edit virtual channels and tasks as well as input 

configurations for hardware devices.  Tasks represent the measurement to be performed and 

consist of one or more virtual channels with timing and triggering properties.  A virtual channel 

consists of a physical channel on the DAQ device and its configuration data such as the signal 

input range and scaling information.  Global virtual channels can also be created using MAX and 

are defined outside of a specific task.  Specifically, global virtual channels can be contained 

within multiple tasks.  If a configuration setting is changed within the global virtual channel, the 

change will take effect in all tasks that include that channel. Thus multiple load cells can be 

easily interchanged for use with the bioreactor.  By creating global virtual channels for each 
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load cell, they can then be selected from a drop down menu bar labeled DAQmx Task as shown 

in figure 2.10. 

 

Figure 2.11. NI USB-9219 signal descriptions. 

The load cell code on the block diagram is setup to start when the user presses the Run Cyclic 

Test button (Figure 2.6).  This calls the DAQmx Task, which has been defined as the load cell, to start 

acquiring data.  The while loop runs continously for the specified number of cycles and load cell data is 

continously acquired.  The sampling rate can be defined within the task as well.  The optimum rate was 

1000 Hz as it yielded the smoothest curve.   

 

Figure 2.12. Load cell commands on block diagram. 
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Using DAQmx tasks also allows for easy calibration before each test.  Right clicking on the 

DAQmx Task (Figure 2.10), pulls up a dropdown menu that gives the option to Edit DAQmx Task.  This 

opens a new window, which allows the user to edit all load cell configuration settings as well as perform 

a bridge calibration (Figure 2.13).  The user clicks on the Bridge Calibration tab and then Calibrate.  This 

permits the user to zero out the weight of the well plate with explants before each compression test. 

 

Figure 2.13. Calibration window in LabVIEW. 

2.3 Validation of Bioreactor GUI 

Accuracy of the bioreactor system was previously validated by McHenry et al [7].  However, 

to confirm accuracy of the system, it should be evaluated every other year.  To ensure the 

frequency of the new GUI, an internal timing loop was included in the program.  This loop 

began and ended with the cyclic displacement portion of the program.  As shown in figure 2.6, 

the run time indicator box displayed the elapsed time.  Using the number of cycles this could be 

back calculated to ensure precise timing. 
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For the purposes of this study, the bioreactor required accurate displacements between 

0.1 and 1 mm.  To ensure correct displacements, motor position was recorded during cyclic 

displacement.  The program was allowed to run for 3600 cycles at various displacements.  Using 

a Matlab program, the change in position was determined for each cycle.  At 1 Hz, for a 

specified displacement of 0.1 mm, the average displacement was 0.105 ± 0.0004 mm.  For a 

displacement of 1 mm, the average displacement was 1.006 ± 0.007 mm. 

2.4 Discussion 

The new LabVIEW GUI meets the needs of the user for cyclic displacement studies.  The 

bioreactor maintains a sterile environment for compression tests of six meniscal explants 

simultaneously.  Manual and automatic movement of the system has been combined into one 

user friendly program.  Manual command allows the quick release and attachment of the 

enclosed well plate fixture.  The cyclic displacement segment of the program offers several 

advantages over the previous SMI program.  More parameters can be easily specified and the 

user is no longer limited to one frequency or set of time and displacement units.  Motor 

position can now be constantly monitored throughout each test to ensure correct 

displacements are reached.  The error in displacement was found to be well within an 

acceptable range, less than 0.1%.  Load cell output can also be monitored in real time.  Motor 

position and load cell data is saved as a text file and can be easily accessed for future analysis. 
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CHAPTER 3: EFFICACY OF P188 IN MITIGATING MENISCAL DAMAGE 

 

 

3.1 Summary 

 Ovine meniscal explants were dynamically compressed using a custom-made bioreactor 

capable of displacement control testing. Knee meniscectomy has been demonstrated to 

increase strains and thus rupture cell membranes in the meniscus potentially leading to post-

traumatic osteoarthritis.  Poloxamer 188 (P188) has shown promise in mitigating tissue 

degradation by selective insertion into the cell membrane.  Cyclic compression testing was 

performed on 5 mm diameter explants, 3 mm in height, at a frequency of 1 Hz for 1 hour.  10% 

and 20% strains were applied to the explants with and without the presence of P188 to 

determine the ability of P188 to prevent degradative changes as a result of high strains.  These 

strains were chosen as 10% strain has been demonstrated to be physiological while 20% strain 

is considered mechanical overloading.  Cell viability analysis showed a 13% reduction in cell 

death at 20% strain with P188.  However, these effects did not continue to 7 days.  No 

significant changes were observed in GAG coverage or mechanical properties for any group.  

Nitric oxide concentration was reduced by 36% at 20% strain with P188 after one day, but P188 

had no effect at 7 days.  These findings suggest P188 could be initially effective in mitigating 

tissue damage. 

3.2 Introduction 

 The menisci are a crucial component of the knee joint.  They provide smooth 

articulation between the rounded femoral condyles and the flat tibial plateau allowing efficient 
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load transfer through the joint [1-4].  The menisci consist of 72% water, while the remaining 

percentage is composed of extracellular matrix components (ECM) components and cells [3].  

The main components of the ECM are collagen and glycosaminoglycans (GAGs).  Collagen is the 

main fibrous component with the bulk of its fibers running circumferentially allowing the 

meniscus to transfer loads through the joint [5].  GAGs are part of larger molecules called 

proteoglycans.  The proteoglycans main function is to absorb water, which gives the meniscus 

its compressive properties [3].  Without healthy, functioning cells, the ECM is not produced and 

the material properties of the meniscus change.  Single, excessive compressive overloading 

injuries have been linked to cell membrane damage and corresponding cell death within the 

meniscus [6]. While the cell has a mechanism for healing small ruptures in the cell membrane, 

tears caused by trauma or disease cannot be fixed without external intervention [7-9].  

Poloxamer 188 (P188), a synthetic surfactant, has shown a promising ability to heal cell 

membranes and potentially increase cell viability after injury. 

 Poloxamer 188 (P188) is a triblock copolymer with the structure of POE-POP-POE with 

POE representing poly(oxyethylene) and POP poly(oxypropylene) with a total molecular weight 

of 8400 daltons.  The POP center provide a hydrophobic core while the flanking POE chains 

create the hydrophilic ends giving P188 the ideal structure to interact with lipid bilayers [10].  

Pƌeǀious ƌeseaƌĐh has deŵoŶstƌated Pϭϴϴ’s aďility to insert selectively into lipid monolayers 

based on surface pressure [11].  Several studies have also been performed in vitro and in vivo to 

examine the effects of P188 on skeletal muscle, neurons, and cartilage with promising results 

[12-17]. 
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  In cartilage, explants that have undergone an impact of 707 N and then been incubated 

in media in the presence of P188 for up to 7 days show a significant reduction in cell death 

[10,14].  Only one study has been performed investigating the effect of P188 on the meniscus.  

This was a six week in vivo study performed by Coatney et al, in which they demonstrated a 

significant reduction in GAG coverage loss after an injection of P188 into the injured knee in a 

rabbit model [17].  A gravity accelerated mass was utilized to impact the hind limb.  The injured 

leg either received an injection of P188 or a sham injection of phosphate buffered saline (PBS) 

with the contralateral limb serving as a control.  After six weeks, the rabbits were sacrificed and 

GAG coverage was analyzed.  While these studies have focused on a single severe impact to the 

tissue, there is a shortage of data on the direct effect of P188 on the meniscus during dynamic 

compression to physiological and supraphysiological levels. 

3.3 Methods 

3.3.1 Meniscus Explants 

Twenty four ovine hind limbs were obtained from the Colorado State University (CSU) 

Veterinary Teaching Hospital (VTH).  The limbs were dissected using sterile techniques and the 

lateral and medial menisci were removed.  A 5 mm biopsy punch was used to remove a total of 

78 meniscal explants.  Explants were removed from the central part of the anterior and 

posterior regions of the lateral and medial menisci.  The explants were cut parallel to the 

superior surface of the meniscus.   
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Figure 3.1 Side view of meniscus with explant cutout. 

Explants were then trimmed to 3 mm in height, keeping the superior region, using an explant 

sizing apparatus.  To allow the tissue time to equilibrate, explants were incubated for 48 hours 

in culture medium (89% DMEM/F12 (1:1), 10% Fetal Bovine Serum, and 1% 

penicillin/streptomycin) at 37oC with 5% CO2.  Media was changed every 24 hours. 

3.3.2 Meniscal Compression 

Explants were compressed for 1 hour at 1 Hz to simulate the equivalent physiological 

conditions of walking for one hour.  Tests were executed in the bioreactor previously 

mentioned.  Briefly, the system is composed of a linear actuator with a motor and load cell 

aligned in a rigid frame in an incubator.  An aluminum plate with six wells containing explants is 

attached to the top of the load cell.  Suspended above the well plate is a plunger with six 

Teflon-filled Delrin compression rods controlled by the linear actuator [29].  To ensure sterility 

of tissue explants, the well plate and plunger are enclosed with a cap for transfer between the 

bioreactor and the sterile tissue hood.  Before coming in contact with explants, the well plate 

and cap were autoclaved and the plunger sprayed thoroughly with 70% ethanol. Six explants 

were compressed simultaneously in unconfined compression.  Meniscal explants were 

randomly assigned into four treatment groups (n=6): 10% strain without P188, 10% strain with 

P188, 20% strain without P188 and 20% strain with P188.  The meniscal explants were centered 

in the bioreactor wells and covered with 350 uL of culture medium either with or without P188 
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(8 mg/ml).  The plunger and cap were secured in place and then the system was transferred to 

the bioreactor in an incubator (37oC, 5% CO2).  The plunger was lowered until just resting on the 

explants and its weight was used as the preload.  Samples were loaded at 1 Hz for one hour 

with time, position and load recorded for the duration of the test using the system software 

(National Instruments LabVIEW).  After loading, explants were sterilely returned to the 

incubator with fresh medium.  Samples were loaded for 1 or 7 days.  Culture medium was 

stored after day 1 and 7 of loading at -80oC. 

 

Figure 3.2 Compression cycle timeline. 

Upon completion of the final loading cycle, explants were returned to the incubator for 24 

hours with fresh culture medium.  After post-loading culture, a center slice was taken using a 

scalpel (#10) for Live/Dead analysis.  Half of the explant was processed for GAG analysis 

(Safranin O/Fast Green staining) and culture medium was stored at -80oC for NO quantification.  

Data collected from the load cell was analyzed for changes in material properties. 

3.3.3 Live/Dead Analysis 

Explant slices were stained using calcein AM and ethidium homodimer per manufacture 

specifications (LIVE/DEAD Viability/Cytotoxicity Kit, Molecular Probes, Eugene, OR).  Explant 

slices were incubated in PBS containing 1 uM calcein AM and 4 uM ethidium homodimer for 25 
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minutes at 37oC.  Following incubation, slices were then washed in PBS twice for 10 minutes at 

37oC.  Live and dead cell counts were determined using image analysis software (CellC, 

Tampere University of Technology, Tampere, Finland). 

3.3.4 GAG Histology 

Tissue explants were fixed in 10% formalin.  After fixation, meniscal explants were 

immersed in a 30% sucrose solution. They were embedded in Optimal Cutting Temperature 

Compound (OCT) (Sakura Finetek, Torrance, CA) and flash frozen using liquid nitrogen.  Explants 

were then cryosectioned into 6 um thick slices.  Staining was performed using hematoxylin, Fast 

Green and Safranin O, which stain cell nuclei black, cytoplasm blue, and GAG red respectively 

(Appendix 5.2.6).  Slices were imaged using a Leitz Laborlux S microscope (Leitz, Oberkochen, 

Germany) and Olympus DP25 camera (Olympus, Center Valley, PA).   

  

A

C 

B 

Figure 3.3 A) Full color image of meniscus B) Analyze particles tool 

for whole menisci C) Color deconvolution tool for area stained with 

GAG (red) D) Analyze particles area for area stained with GAG 

D 
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GAG coverage was analyzed using Image J (NIH, Bethesda, MD) with FIJI package.   Images 

were converted to 8 bit images.  The Analyze Particles tool was utilized to determine total area 

of the image.  The area stained red is associated with GAG coverage and was separated from 

the image using the Color Deconvolution tool.  The image could then undergo thresholding and 

analyze particles to determine GAG coverage.  These areas were used to calculate a GAG 

coverage percentage (Figure 3.3). 

3.3.5 Nitric Oxide Quantification 

Total ŶitƌiĐ oǆide ǁas ƋuaŶtified fƌoŵ ĐoŶditioŶed ŵedia as peƌ ŵaŶufaĐtuƌeƌ’s iŶstƌuĐtioŶs 

(Cayman Chemical, Ann Arbor, MI) (Appendix 5.2.7).  Briefly, nitric oxide exists in two stable 

forms, nitrate and nitrite.  The assay converts all nitrate to nitrite using the Griess reaction, 

which produces a colored azo dye.  Absorption is read at 540 nm using a spectrophotometer.  

Using known concentrations of nitrite, a standard curve (Appendix 5.3.3) is generated and 

utilized to convert absorption values to concentration. 

3.3.6 Material Properties Analysis 

Matlab was utilized to take the absolute value of the force vs time curve.  For each 

compression test, the local peaks were found.  A second order power curve, y = a*x^b+c, was fit 

to the data. The local peak values were averaged for each group for each time point, resulting 

in one curve fit per group per time point. 

3.3.7 Statistical Analysis 

One-way analysis of variance (ANOVA) with a post hoc Tukey test using Minitab software 

(Minitab17, State College, PA) was performed on cell viability, GAG coverage, and NO assay 



47 

 

data to assess differences between strain levels and P188 treated and non-treated groups.  

Regression analysis was utilized to determine changes in material properties of menisci.  R-

squared values were used to determine fit of regression. P < 0.05 was considered significant for 

all tests 

3.4 Results 

3.4.1 Live/Dead 

 

Figure 3.4. Results from Live/Dead assay for 1 and 7 day studies.  * denotes significance p<0.05 

Significant differences were found after 1 day of compression (p<0.001) (Figure 3.4).  

Without P188, the 10% strain group had an increased percentage (21%) live cells compared to 

group undergoing 20% strain.  Significant differences were also shown between 20% strain 

without P188 and 10% strain with P188 as well as between 10% without P188 and 20% with 
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P188.  After seven days of compression, there were no significant differences between groups 

with or without P188 or between 10% and 20% strains. 

3.4.2 GAG  

 

Figure 3.5. Comparison of GAG coverage for 1 and 7 days. ANOVA revealed no significant differences between 

strain groups, with or without P188. 

No significant differences were found in percent GAG coverage after one or seven days 

(Figure 3.5), between groups with or without P188, or between strain groups.  However, while 

not significant, there was a decrease in GAG coverage for samples compressed to 20% without 

P188 compared to only 10% compression. 
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3.4.3 NO Assay 

 

Figure 3.6. Comparison of nitric oxide concentration for 1 and 7 days. * denotes significance p<0.05 

After 1 day, general trends showed smaller NO concentrations in the groups treated 

with P188 compared to the non-treated groups (Figure 3.6).  There were no significant 

differences between 10% strain groups with or without P188.  NO concentration was also found 

to be significantly lower in the 20% strain P188 treated group compared to the 10% and 20% 

groups without P188 (p<0.006).  The 10% P188 treated group was significantly lower than the 

20% non-treated group (p<0.006).  No significant differences were found after 7 days between 

strain groups or between groups with or without P188. 
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3.4.4 Mechanical Data 

 

Figure 3.7. Representative data for second order power curve fit.  

Using force peaks isolated from the cyclic displacement graphs versus time, a second order 

power curve, y = a*x^b+c, was fit to the data.  In the first 500 cycles a rapid drop in load 

occurred with little change for the remaining 3000.  Figure 3.7 shows an example of the 20% 

strain group without P188 from the seventh day of a seven day study.   

 

Figure 3.8. ͞a͟ ĐoeffiĐieŶt oǀeƌ ϳ daǇs foƌ ďoth stƌaiŶ gƌoups, ǁith aŶd ǁithout Pϭϴϴ. LiŶeaƌ ƌegƌessioŶ  
analysis revealed no significant differences over 7 days for strain groups or with/without P188. 
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Figure 3.9. ͞ď͟ ĐoeffiĐient over 7 days for both strain groups, with and without P188.  Linear regression 

analysis revealed no significant differences over 7 days for strain groups or with/without P188. 

 

 

Figure 3.10. ͞Đ͟ ĐoeffiĐieŶt oǀeƌ ϳ daǇs foƌ ďoth stƌaiŶ gƌoups, ǁith aŶd ǁithout P188.   Linear regression 

analysis revealed no significant differences over 7 days for strain groups or with/without P188. 

 

The coefficients of these curves (a,b,c) (Appendix 5.3.4) were compared over time using 

linear regression within groups to examine changes in material properties (Figure 3.8-10): a 

relates to stiffness, b to time-dependence and c is a scaling factor.  No significant differences 

were found between strain groups or P188 treated and non-treated groups. 
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3.5 Discussion 

Previous research has shown the intact meniscus undergoes 10% strain physiologically, 

while removal of 30% of the meniscus caused strains to almost double to 20% [19].  Hence 

these two strains were chosen for dynamic compression testing as physiological and 

supraphysiological.   It was expected that a strain of 20% would cause significant cell death in 

ĐoŵpaƌisoŶ to ϭϬ% stƌaiŶ.  Cell ǀiaďilitǇ assaǇs shoǁed pƌoŵise iŶ ͞saǀiŶg͟ Đells that had ďeeŶ 

overloaded at the one day mark.  There was no significant difference in cell viability between 

10% strains groups treated or non-treated, indicating that P188 does not have adverse effects 

at physiological strains.  As expected, significant differences did occur between 10% and 20% 

strain in the non-treated group.  The 10% strain level had a higher percentage of live cells (21%) 

compared to 20% strain.  With the application of P188, this difference was decreased to 8%.  

Although the percentage of healthy cells did not recover to initial levels at the 10% strain no 

P188 group, there was a significant reduction in cell death.  Phillips and Haut demonstrated 

increases in cell viability as high as 49% in chondrocytes with the application of P188 over a 24 

hour period [10].  Baars et al showed a 45% reduction in DNA fragmentation up to 7 days post-

impact in the presence of P188 [14].   However, both studies performed a single injurious 

impact to the chondrocyte versus consistent dynamic strains.  While P188 may have beneficial 

effects after an initial traumatic impact, its efficacy may be reduced with consistent 

overloading.  DǇŶaŵiĐ loadiŶg ŵaǇ also ĐoŶtƌiďute to ͞ǁashiŶg out͟ dead Đells oǀeƌ the Đouƌse 

of seven days.  These cells may be removed from the tissue and released into the cell media.  

Future studies should assay the media for live and dead cells to gain a full representation of cell 

viability within the meniscus.  Fithian et al also demonstrated that bovine meniscal tissue has 
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one-sixth the permeability of articular cartilage [18].  This difference in permeability may 

account for the difference in cell viability in cartilage vs meniscus tissue.  Fluorescent labeling 

may be a viable option to track diffusion of P188 into the meniscus and optimize P188 

concentration.  Cartilage consists of a single cell type, chondrocytes, whereas menisci have 

fibroblast- and chondrocyte-like cells.  Fibroblast-like cells are found at the outer third of the 

meniscus, but the inner two-thirds consist of chondrocyte-like cells.  P188 may affect each cell 

type differently and in turn affect each zone of the meniscus in distinctive ways.  Further 

investigation is necessary to elucidate the effect of P188 on each cell type. 

GAG is an essential part of proper biomechanical function as it chemical properties 

retain water, which endows the meniscus with its compressive abilities [20,21].  The loss of 

GAG is associated with reductions in the coefficient of viscosity and modulus of relaxation [21].  

Over the seven day study, there were no significant changes in GAG coverage between strain 

levels or P188 treated or non-treated groups.  As there was no change in GAG coverage, it was 

expected there were be no change in mechanical properties.  Mechanical data from this study 

indicated no change in mechanical properties supporting this conclusion.  In the only known 

study investigating the effect of P188 on the meniscus, Coatney et al demonstrated in an in vivo 

study over 6 weeks, that P188 was able to retain GAG coverage compared to the non-treated 

groups [17].  However, despite this change in GAG coverage, changes in mechanical properties 

were not observed.  This largely may be due to the small sample size.  Little to no research has 

been done on the time frame over which material properties of the meniscus change.  Further 

investigation is necessary in order to correlate changes in GAG coverage with mechanical 

properties, as remodeling of meniscal tissue is poorly understood.   



54 

 

Despite not observing altered mechanical properties, Coatney et al observed significant 

changes in GAG coverage over 6 weeks in impacted, non-treated limbs in vivo.  Seven days may 

not be a substantial amount of time to observe changes in GAG coverage in meniscal explants.  

By extending the study to 14 or 21 days, changes in GAG coverage may be observed.  However, 

this extended period of time in vitro may be difficult to attain in culture with sterility.  There is a 

great deal of conflicting literature on how GAG is affected by mechanical overloading.  Two 

methods of assessing GAG levels are commonly used.  The first is as described in this study, 

using histological means to assess GAG coverage of a cross-section of the tissue.  The second 

method is assaying GAG concentrations in conditioned media.  However, no means of 

comparing these two assays has been developed.  A study by Hufeland et al demonstrated a 

single compression with a strain of 50% was necessary to increase GAG release to the media 

[22].  Killian et al showed upregulated GAG concentrations in the media occurred at 20% 

dynamic strain [23].  GAG concentrations may increase in the media immediately after 

compressive cycles, but this change may take multiple weeks for a visual change to occur in 

GAG coverage within the tissue.  Further investigation into this relationship is required. 

High concentrations of nitric oxide have been found in osteoarthritic synovial fluid and is 

believed to regulate catabolic activity in meniscus and cartilage [24, 25].  High levels of NO 

cause tissue degradation, by reducing production of collagen II, and apoptotic cell death 

[26,27,28].  McHenry investigated the relationship between NO concentration and dynamic 

compression of meniscal explants in load and displacement controlled experiments and found 

NO concentration was upregulated at 20% strain [29].  Fink et al and Shin et al also showed an 

upregulation of NO in dynamic compression [30, 31].  However, they compressed meniscal 



55 

 

explants consistently for 24 hours, which is not physiologically realistic.   In this study, increased 

levels of strain did not affect the NO concentration in the untreated group.  The explants were 

only compressed for one hour and that may not have been sufficient to see strain dependent 

changes in NO concentration.  However, both 10% and 20% strain groups had decreased NO 

concentration with the application of P188.  There was 36% reduction in NO concentration 

between 20% treated and untreated groups.  This indicates the P188 may be interfering with 

the NO signaling cascade, which could slow tissue degradation. 

To the best of our knowledge, this is the first study to directly examine the effects of 

P188 on the dynamic compression of meniscal explants.  The bioreactor setup mimics an hour 

of walking per day in an attempt to understand how P188 interacts with physiological and 

supraphysiological loaded meniscal tissue. While P188 shows promising results within the first 

24 hours, this study had several limitations.  Small samples sizes limited determination of 

mechanical properties.  Due to the setup of the bioreactor only two independent mechanical 

data sets were available per group.  The concentration of P188 had been earlier optimized for 

cartilage explants [10].  Due to differences in permeability between cartilage and meniscus an 

optimization of P188 concentration may be necessary for the meniscus.  While there were no 

visible changes in viscosity, future investigations should examine the effect of P188 on media 

viscosity to ensure there is no interference in loading with the bioreactor or in meniscal tissue 

uptake.  Longer time periods should also be examined, particularly to investigate changes in 

GAG Đoǀeƌage.  Pϭϴϴ shoǁs pƌoŵisiŶg ƌesults iŶ the fiƌst Ϯϰ houƌs aŶd appeaƌs to ͞saǀe͟ Đells.  

It is ĐuƌƌeŶtlǇ uŶkŶoǁŶ, ǁhetheƌ these ͞saǀed͟ Đells ǁill still fuŶĐtioŶ as normal, healthy cells.  

Although they appear to be alive according to Live/Dead assays, the damage due to overloading 
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may cause the cells to form an abnormal matrix leading to changes in material properties.  The 

best course of action could be to let the cells go through the natural process of cell death.  

Further investigatioŶ is Ŷeeded to asĐeƌtaiŶ the effeĐt of these ͞saǀed͟ Đells oŶ the suƌƌouŶdiŶg 

matrix.  Polymerase chain reaction (PCR) could be utilized to examine various biomarkers that 

indicate cell health.  Pharmaceutical intervention is an encouraging avenue to consider to 

mitigate molecular damage after mechanical trauma to meniscal tissue.  Further investigation 

of P188 may provide a method to slow tissue degradation and prevent the development of 

osteoarthritis. 
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CHAPTER 4: CONCLUSION 

 

 

To investigate the effects of P188 on the meniscus, the goals of this project were to: 1) 

create a user friendly graphical user interface (GUI) for a custom bioreactor capable of 

displacement control for precise loading of meniscal explants to physiological and 

supraphysiological strains; 2) determine the efficacy of P188 in mitigating meniscal tissue 

damage through cell viability, mechanical data and histological analysis. 

Briefly, the bioreactor consists of a linear actuator with a motor and load cell aligned in a 

rigid frame in an incubator.  An aluminum plate with six wells containing explants is attached to 

the top of the load cell.  Suspended above the well plate is a plunger with six Teflon-filled Delrin 

compression rods controlled by the linear actuator.  The bioreactor maintains a sterile 

environment for compression tests of meniscal explants.   To meet the requirements of the 

user, the bioreactor must be capable of manual control, displacement control, real time 

monitoring of motor position and load cell data, and interchangeable load cells that are easily 

calibrated.  Manual and automatic movement of the system has been combined into one user 

friendly program.  Manual command was achieved with the use of a rotary optical encoder, 

which allows the quick release and attachment of the enclosed well plate fixture.  The cyclic 

displacement segment of the program offers several advantages over the previous SMI 

program.  More parameters can be easily specified and the user is no longer limited to one 

frequency or set of time and displacement units.  The bioreactor can be run for one hour or 

continuously over multiple days.  Motor position can now be constantly monitored throughout 

each test to ensure correct displacements are reached.  Load cell output can also be monitored 



60 

 

in real time.  Motor position and load cell data is saved as a text file and can be easily accessed 

for future analysis.  Utilizing the DAQmx feature of LabVIEW, global virtual channels can easily 

be configured to interchange load cells within the program.  This device driver also provides a 

simple calibration process for the load cells.  Using LabVIEW, the outlined requirements were 

fulfilled to create a user friendly graphical user interface (GUI) for a custom bioreactor capable 

of displacement control for precise loading of meniscal explants to physiological and 

supraphysiological strains. 

This was the first study to examine the direct effect of P188 on the dynamic 

compression of meniscal explants.  Meniscal explants were examined at 1 or 7 days after 

undergoing 10% or 20% strain with or without P188 treated culture media.  Initial results in the 

first 24 hours show promising potential for P188 as a pharmaceutical intervention in meniscal 

tissue degradation.  While cell viability was unable to return to initial physiological levels after 

one day, the gap between 10% and 20% strain narrowed from 21% to 8%.  GAG coverage 

showed no changes over the seven day study.  However, remodeling of meniscal tissue is poorly 

understood and further investigation is necessary to elucidate the relationship between 

mechanical overloading and GAG coverage.  Congruent with the GAG coverage results, there 

were no changes in material properties of the meniscal explants.  Again, while it is known that 

loss of GAG coverage results in changes in material properties of the tissue, the timeline for the 

changes to be enacted is unknown.  P188 also showed promise in reducing nitric oxide 

concentration (36%) after one day in the 20% strain group, which may slow tissue degradation 

and apoptotic cell death.  While P188 has shown promise in the initial 24 hours of application, 
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several avenues of research should be pursued to reveal its full potential as a pharmaceutical 

intervention in meniscal tissue degradation. 

Future Direction 

 Although P188 was shown to increase cell viability within the first 24 hours of 

appliĐatioŶ, the oǀeƌall health of these ͞saǀed͟ Đells is uŶkŶoǁŶ.  While the iŶtegƌitǇ of the Đell 

ŵeŵďƌaŶe ŵaǇ ďe ƌestoƌed, the Đell’s aďilitǇ to fuŶĐtioŶ as a Ŷoƌŵal, healthǇ Đell is uŶĐleaƌ.  To 

further investigate polymerase chain reaction (PCR) should be utilized to investigate cell 

sigŶaliŶg of the ͞saǀed͟ Đells.  If iŶflaŵŵatoƌǇ ŵaƌkeƌs, suĐh as iŶteƌleukiŶ-1 alpha or tumor 

necrosis factor alpha, are still upregulated in these saved cells, the best course of action may be 

to let them go through the natural process of cell death.  Healthy cells are responsible for 

producing the extracellular matrix (ECM), collagen and GAG, which gives the meniscus its 

ŵateƌial pƌopeƌties.  These ͞saǀed͟ Đells ŵaǇ ďe pƌoduĐiŶg aŶ aďŶoƌŵal ECM, ǁhiĐh would 

ĐhaŶge the ŵeŶisĐi’s ŵateƌial pƌopeƌties oǀeƌ tiŵe.  LoŶgeƌ studies aƌe ƌeƋuiƌed to eǆplaiŶ this 

relationship.  By extending studies to 14 or 21 days, visual changes in GAG coverage may be 

observed.  The in vitro study could be further optimized by investigating varying concentrations 

of P188.  The concentration used in this study (8 mg/ml) was optimized for articular cartilage.  

Meniscal tissue has a lower permeability than cartilage and higher concentrations of P188 may 

be necessary to maximize uptake.  A previous study has shown partial meniscectomy to 

increase strains seen by the meniscus to 20%.  However, this was a small study and biological 

tissue properties often vary greatly from person to person.  The supraphysiological compression 

strain may need to be increased from 20% to 30% or 40% in order to see effects of P188.    

Besides further in vitro studies, the effect of P188 on the whole knee joint should be 
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investigated in vivo.  Understanding the complete effect of P188 on the knee joint is crucial in 

determining its efficacy as a pharmaceutical intervention to slow tissue degradation and 

prevent the development of post-traumatic osteoarthritis. 
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CHAPTER 5: APPENDIX 

 

 

5.1 Bioreactor User Manual 

Bioreactor Assembly and Usage Manual 

Component Connections (Assembly Overview) 
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Figure 5.1.1: Bioreactor System (number labels indicate part numbers) 
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Parts within this manual will be referenced by both the formal name of the part, as well as the 

number assigned to the part. 

 

 

 

 

 

 

 

 

 

 

 

Component 
Number 

(Diagram) 

Component Name Brief Description 

1 Frame Holds the plunger, motor, and load cell. 
2 Linear Actuator Elevates and lowers, thus compressing 

the specimens within the load cell. 
3 SM1720 Motor Translates Optical Rotary Encoder’s 

digital signals to vertical movements. 
4 Optical Rotary 

Encoder 
Senses changes in light due to manual 
rotation, allowing the user to rotate the 
encoder in order to move the motor, and 
thus plunger up and down. 

5 NI-DAQ Card and 
Board 

Allows for signal from the load cell to 
be sent to the computer and understood 
through the NI LabVIEW program. 

6 NI USB-9219 
Connectors 

Provides four channels of universal 
analog input with integrated signal 
conditioning. 

7 1200 Precision 
Universal Low 

Profile Load Cell 

Stores specimen samples, and undergoes 
compression and tension.  Contains a 
strain cell which reads the changes in 
resistance (which then translates to 
changes in strains). 

Table 5.1.1: Components necessary to assemble the bioreactor, with names and correlated diagram 

numbers. 
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1.) Frame 

 

 

 The Frame (1) of the device serves the purpose of holding the Linear Actuator (2), Motor (3), and 

Load Cell (7), in place.  The frame can be seen in Figure 2 above.  The Frame is a component that was 

specially manufactured for the purpose of conducting material tests. 

The Linear Actuator (2) can slide in and out of the frame, and is secured to the Frame (1) with bolts. The 

Linear Actuator (2) and Motor (3) are connected with bolts that can also be undone to allow for 

separation.  This piece is the critical basic component for holding the entire assembly together, and 

allows users to conduct tension and compression tests on materials. 

 

 

 

 

 

 

 

 

 

Figure 5.1.2: The Frame of the Bioreactor 
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2.) Ultra Motion BUG Linear Actuator 

(Part #4-2B.125-SM17-3.2-1NO-B/EC4) 

The Linear Actuator (2) slides in and out of the frame freely once the bolts (labeled with the red circle) 

are undone.  The Linear Actuator is then slid upward (indicated by the red arrow) to be removed from 

the fixture.  The Linear Actuator (2) is connected to a box at the top of the fixture which contains a belt 

that allows the motor to translate its torsional motion to linear motion in the Actuator.  The box at the 

top can be disassembled by removing the screws and opening the box.  This is only necessary when the 

motor is not functioning correctly—then the belt may need to be checked. 

Finally, the cords circled in blue in Figure 3, are connected to the Right and Left Limit Ports in the Smart 

Motor (3).  This connection, and its importance, is further expanded on in the Smart Motor (3) section.  

The user manual for the Linear Actuator can be seen on the following pages, and was taken from: 

http://www.ultramotion.com/linear-actuators/#b-series 
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Figure 5.1.3: UltraMotion Linear Bug Actuator 
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Figure 5.1.4 Specifications for Ultra Motion Bug linear actuator 

 

Figure 5.1.5. Specifications for Ultra Motion Bug linear actuator continued. 

 

 

 



68 

 

3.) SM1720 Smart Motor  

The SM1720 Smart Motor (3) provides the mechanical power to conduct material tests on samples and 

can be seen in Figure 4.  It functions through translating torsion forces into linear forces in the actuator.  

It is the central plug-in location point for many of the other parts of the device.   

Located on the back of the Motor (3) are several ports that allow the connection of the Motor (3) to the 

computer and to the power source, Optical Rotary Encoder (4), and to the Linear Actuator (2).  The 

instructions for connecting each of the aforementioned components can be seen on the following 

pages. 

A diagram of the wire port configurations can be seen on the following page.  The diagram represents 

the back of the motor while the motor is on its bottom side (which is the left side of the motor in Figure 

ϱ, loĐated oŶ the folloǁiŶg pageͿ.  The sĐheŵatiĐ foƌ the ŵotoƌ’s ĐoŶŶeĐtioŶ outputs ǁas ƌetƌieǀed fƌoŵ 
the Animatics website at: http://www.animatics.com/download/legacy/17pin.pdf 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 5.1.6: SM1720 Smart Motor 
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 Connecting the Motor (3) to the computer and power source: 

In order to connect the motor to the power source and the computer, the Main Connector is used.  The 

Main Connector plug-in is a cord that already connects both the power and computer cables.  The 

power cord is the thicker of the two cords, while the computer cord is the thinner of the two.  Connect 

the thicker power cord to the power outlet.  Connect the thinner computer cord to the computer 

thƌough the Đoŵputeƌ’s seƌial poƌt.   

Connecting the Motor (3) to the Optical Rotary Encoder (4):  

In order to connect the Optical Rotary Encoder (4) to the motor, several wires must be connected.  Since 

the Optical Rotary Encoder (4) was attached to the motor through the soldering of the wires, the colors 

of the wires on the Rotary Encoder (4) end diffeƌ fƌoŵ the Đoloƌs of the ǁiƌes oŶ the Motoƌ’s ;ϯͿ eŶd.  
The color changes and connection port purposes can be seen in Table 2, located below. 

 

Optical Rotary 
Encoder Wire Color 

Cable Connection to Motor 
Wire Color 

Function of Wire 

Red Red Red 5VDC +/- 5% @ 30 mg 
max 

Orange White B Channel 
Yellow Green A Channel 
Green  Black Ground 

 

Table 5.1.2: Wire connection color changes and functions. 

Figure 5.1.7. Pin out of Animatics Smartmotor SM1720. 
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The Optical Encoder (4) wires must be connected to specific ports on the Motor (3).  These connections, 

as well as the other connections necessary for the motor, can be seen in Figure 6 below. 

 

Connecting the Motor (3) to the Linear Actuator (2): 

As is demonstrated in Figure 6 above, the LiŶeaƌ AĐtuatoƌ ;ϮͿ is plugged iŶto the Motoƌ’s Left aŶd Right 
Limit Ports.  This connection limits how far up or down the Linear Actuator (2) will move, and can be 

changed with programming. 

 The useƌ’s ŵaŶual, aŶd otheƌ ĐƌitiĐal iŶfoƌŵatioŶ, CAD files, aŶd pƌogƌaŵŵiŶg softǁaƌe ĐaŶ ďe 
found at: 

http://www.animatics.com/legacy-downloads.html?task=view 

The useƌ’s ŵaŶual ĐaŶ ďe seeŶ oŶ the following pages, and was also retrieved from the above website. 

 

 

 

 

Figure 5.1.8: Actual wire configuration for the SM1720 Smart Motor 
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4.) Series 600 Optical Rotary Encoder 

 

The Optical Rotary Encoder (4), seen in Figure 7, allows the user to manually turn the knob on 

the Encoder to induce movement in the Linear Actuator (2).  The Optical Rotary Encoder (4) has wiring 

that is soldered onto the connection cable that leads to the Motor (3) (as was stated within the Motor 

(3) section of the manual).  Due to the soldered connection, the colors of the wires do not match at both 

ends, and the instructions for wiring the Optical Encoder are also included in the Smart Motor (3) 

section of this manual.  In order to attach a new Optical Rotary Encoder, the purposes of each electrical 

wire must be identified and matched to the wire of the same purpose that connects to the motor. 

The specifications for the optical encoder can be seen on the following pages, and was taken from State 

EleĐtƌoŶiĐ’s ǁeďsite at: 

http://www.potentiometers.com/pdf/600.pdf 

Along with these specifications, more data on the configuration and installation of the optical encoder 

can be seen following the specifications, and was found on the Honeywell website at: 

http://sensing.honeywell.com/600-series-install-50099564-a-en-final-11oct14.pdf?name=600-128-CBL 

Figure 5.1.9: Series 600 Optical Rotary Encoder 

http://www.potentiometers.com/pdf/600.pdf
http://sensing.honeywell.com/600-series-install-50099564-a-en-final-11oct14.pdf?name=600-128-CBL
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5.) NI - DAQ Card and Board 

The NI-DAQ Card and Board, shown in Figure 8 above, allow for the signal received from the 

Load Cell (7) and translated into readable data within LabVIEW.  The NI-DAQ Card is inserted into the 

board, and allows for the NI USB Connectors (6) to be inserted into the Card.  A simplified diagram of the 

NI-DAQ Board can be seen in Figure 9 below. 

Figure 5.1.12. Close-up view of NI-USB 9219 module showing terminal connectors 

Figure 5.1.10: NI-DAQ Card and Board 

Figure 5.1.11: Simplified schematic of the NI-DAQ Card and Board 

Configuration 

NI-DAQ Card 



73 

 

Figure 5.1.12. Close-up view of NI-USB 9219 module showing terminal connectors  

6.) NI USB-9219 Connectors 

In order to read data acquired from the Load Cell (7), the wire from the load cell must be 

connected to the NI USB-9219 Connectors (6), seen up close in Figure 10.  The wires from the 

Load Cell (7) are connected in the manner demonstrated in Figure 11 below.  The purposes of 

the terminals are indicated in Table 3 on the following page.  In order to connect the wires to 

the USB-9219 Connectors (6), use a flathead screwdriver with a head smaller than 2.3 x 1.0 mm.  

Insert the screwdriver into the spring clamp activation slot and press the wire into the 

corresponding wire connecting terminal (as per the instructions provided with the USB-9219 

Connectors (6)).  Once the screwdriver is removed the terminal will clamp onto the inserted 

wire.   

 

 

 

 

 

 

 

 

 

 

 

Wire 

Connecting 

Terminals 

1 

2 

3 

4 

5 

6 

Figure 5.1.13: Wire configuration to connect the load cell to 

the NI USB-9219 terminal connectors 
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Terminal 
Number 

Signal 
Name 

Signal Description for Full 
Wheatstone Bridge Connection 

1 T+ TEDS Data 
2 T- TEDS COM 
3 EX+ Positive excitation  
4 HI Positive input signal 
5 EX- Negative excitation  
6 LO Negative input signal 

 

 The installation instructions and specifications for the NI USB-9219 Connectors can be seen on 

the following pages.  This information was removed from the National Instruments website at: 

http://www.ni.com/pdf/manuals/372407a.pdf 

 

6.) 1200 Precision Universal Low Profile Load Cell 

 

   

The Load Cell (7), seen in Figure 12 above, is connected to the NI USB-9219 Connectors (6) so 

that LabVIEW may aquire data from the tests conducted.  The Load Cell (7) contains a Full-Wheatstone 

Bridge configuration, as is demonstrated in the wiring instructions for the NI USB-9219 Connectors (6).  

The load cell installation specifications and installation instructions can be seen on the following pages.  

This iŶfoƌŵatioŶ ǁas takeŶ fƌoŵ the pƌoduĐeƌ’s ǁeďsite at:  

Figure 5.1.14: The load cell connected to rigid frame of bioreator 

Table 5.1.3: Terminal names and descriptions for the Full Wheatstone Bridge Configuration 

http://www.ni.com/pdf/manuals/372407a.pdf
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http://www.interfaceforce.com/index.php?1200-Precision-Universal-LowProfile%99-Load-Cell-Tension-

and-Compression&mod=product&show=5 

 

 

Figure 5.1.15. Load cell specifications 

http://www.interfaceforce.com/index.php?1200-Precision-Universal-LowProfile%99-Load-Cell-Tension-and-Compression&mod=product&show=5
http://www.interfaceforce.com/index.php?1200-Precision-Universal-LowProfile%99-Load-Cell-Tension-and-Compression&mod=product&show=5
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Figure 5.1.16: Load cell dimensions 
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A well plate is connected, and Figure 13 shows a top view.  This part is where the samples can be 

loaded and sealed.  The configuration of the load cell is such that it allows for the samples to be 

completely sealed off from the environment—allowing for the user to place and maintain live tissue 

samples within the load cell.  The samples are to be place symmetrically within the wells so that the load 

cell does not experience uneven strain, and thus produce faulty data.  Media is to be placed into the 

wells as well in order to keep the tissue samples alive.    

 

 

Figure 5.1.17. Top view of well plate 
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5.2 Standard Operating Procedures 

5.2.1 Sterile Tissue Harvest 

Chemicals 

 Sterile PBS 

 Growth Media 

 70% Isopropanol (sterilization) 

Equipment 

 Hood 

 Scalpel blades (x per knee) 

 Scalpel 

 Tweezers 

 Sizing apparatus 

 Biopsy Punches (6 mm) 

 Sterile 48 well plate 

 Sterile 6 well plate 

 Kimwipes 

 Wire to push explants out from biopsy punch 

 Cutting board 

Protocol 

Preparation of sterile hood 

1. Wear gloves 

2. Spray down interior of hood with 70% isopropanol and wipe with Kimwipe 

3. Cover entire bottom surface with aluminum foil and spray with 70% isopropanol 

4. Fill 4 wells with sterile PBS in 6 well plate.  Use one well per meniscus.  Label appropriately 

Cutting Knee 

1. Outside of hood, remove excess muscle and fascia without cutting into knee joint capsule. 

2. Using bone saw, cut approximately 3 inches from knee joint on both sides. 

3. Spray outside of joint thoroughly with 70% isopropanol and place in hood.   

4. Carefully open joint capsule, taking care to avoid touching menisci.  Once joint capsule is open, 

do not remove from hood.  The knee joint within the capsule is sterile. 

5. Dispose of femur. 

6. Using a fresh scalpel blade and tweezers, carefully cut away menisci from the tibial plateau.  

Place menisci in appropriately labeled wells of PBS. Dispose of tibia. 

7. Spray and wipe surface down with 70% isopropanol.   

8. Moving to the clean cutting board (still in hood), carefully cut out explants using biopsy punch.  

Rotate the punch carefully as needed to cut through meniscus. 
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9. Use wire to push explant out of biopsy punch.  Center the sizing apparatus on explant and push 

down in one fluid motion to achieve desired size. 

10. Place the explant in the 48 well plate (superior surface to the top) and add 1 mL warm (37oC) 

growth media.  Place lid on plate and move to incubator. 

11. Media should be changed after 24 hours. 

 

5.2.2 P188 Media Preparation 

 

Chemicals 

 “teƌile DulďeĐĐo’s Modified Eagle Medium (DMEM) 

 “teƌile Haŵ’s FϭϮ ;FϭϮͿ 
 Penicilin/Streptomyosin 

 Fetal Bovine Serum (FBS) 

 70% Isopropanol (sterilization) 

 P188 

Equipment 

 Hood 

 2 Sterile Media Bottles 

 Pipettes 

 Syringe 

 Sterile Filter Tip (0.45 um) 

 Kimwipes 

 Gloves 

Protocol for Growth Media 

 1% Penicilin/Streptomyosin 

 10% FBS 

 89% DMEM:F12 [1:1] 

 8 mg/mL P188 

Procedure 

1. Spray down interior of hood with 70% isopropanol and wipe with KimWipe.  Spray all chemical 

bottles and equipment with 70% isopropanol before placing in hood. 

2. Loosen all caps of chemicals and sterile media bottle, but keep bottles covered with caps. 

3. Without touching the containers, pipette half of DMEM:F12 into empty media bottle. 

4. Add P188.  Close bottle tightly and place in 37oC water bath until P188 dissolves, occasionally 

swirling media. 
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5. In a new sterile bottle, add second half of DMEM:F12. 

6. Attach sterile filter to syringe.  Remove plunger from syringe and hold over sterile media bottle.  

Pour aliquots of Pen/Strep and FBS into syringe and depress plunger fully. 

7. Sterile filter F12/P188 mixture using syringe into bottle containing DMEM, Pen/Strep, and FBS. 

8. Aliquot into 50 mL vials. 

9. If using media soon, place in water bath (37oC).  If finished, return to fridge. 

 

5.2.3 Meniscus Live Dead Protocol 

Equipment/Supplies: 

Item Location 

Specimens (Meniscus) Will be in test tubes from mechanical testing 

Scalpel Out from indentation testing 

 Tweezers 

1x PBS 

Drop cloth  

Test Tube  In Test tube drawer 

Micron tube strips (2-4 depending on 

sample size) 
On shelf above test tube drawer 

Micron test tube holder Next to micron test tube strips 

Micro pipets (grey, orange, yellow) On counter next to PBS 

4 Pipet tips  In pipet drawer 

Calcine In freezer in small cylindrical container 

Ethidium Bromide 

Un-subbed slides In slides drawer 

DI water On conunter 

Sharps Container Under dissection table 

Portable Hard Drive In portable hard drive drawer 

 

Steps for preparation 

1. Place number of needed micron tubes in the micron test tube holder (x2). 

2. Fill first row with PBS 

3. Fill one test tube with 4 mL of PBS. 

4. Remove Calcine and Ethidium Bromide from freezer so they can start to thaw 

a. Be sure to keep them unexposed to the lights 

5. Turn on Incubator (~ 27 degrees) 

6. Set all pipettes to appropriate measures 

a. Grey top – 1 uL 

b. Orange top – 8 uL 

c. Yellow top – 150 uL 
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Steps for Slicing 

1. Take as thin of a slice from the middle of the explant. 

2. Place thin slice in micron vial. 

i. Repeat for all specimens. 

 

Steps for Staining  

1. Turn off lights 

2. Add 1uL of Calcine  to test tube 

3. Add 8 uL of Ethidium Bromide to same test tube 

4. Vortex both test tubes to mix stain into PBD 

5. Pipette 150 uL of stain into empty micron test tube rows 

6. Transfer meniscal slices from PBS micron test tube rows to fluorescence rows 

7. Cap the rows 

8. Slightly shake rows to mix 

a. Be sure not to mix up what specimen is what 

b. Make sure all meniscal slices are at bottom of test tube 

9. Place in incubator for 25 mins 

10. Return Calcine and Ethidium Bromide vials to freezer 

11. Remove from incubator 

12. Move  meniscal slices to PBS micron test tube rows 

13. PlaĐe iŶ iŶĐuďatoƌ foƌ ϭϬ ŵiŶs foƌ a ͞ǁash͟ 

14. Repeat wash 

15. Remove from incubator  

16. Turn off incubator 

17. Remove slices from PBS and place on slides 

18. Cover specimens with DI water to stay hydrated 

 

Steps for Imaging  

1. Turn off light 

2. Turn burner on 

3. Be sure in 2x 

4. On Desktop open CellSense 

5. Switch scope to camera 

6. Will use green filter to image red (~600-900ms VERY variable) 

7. Will use blue filter to image green (~1-2s but VERY variable) 

8. Take photos of each image and save 

a. Ex. ZOC5_LLA_2x_G 

 

Steps When Done Imaging 

1. When all images have been taken close CellSense 

2. Turn burner off 

3. Place all slides in Sharps container 
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5.2.4 Safranin O Staining Protocol 

SAFRANIN O STAINING PROTOCOL - MENISCUS 

TIME: 75 MINUTES 

 

Item Amount 

Slide Holder w/ Handle NA 

Tupperware 1 

dH20  

Tap Water  

Weigerts Iron Hematoxylin 

Working Solution (50:50 Parts A 

& B) 

See Recipe 

Fast Green FCF Solution See Recipe 

1%Acetic Acid Solution See Recipe 

0.1% Safranin O Solution See Recipe 

Ethanol: 95% & 100%  

Xylene  

 

Prepared Solutions 

 Weigerts Hematoxlyin Working Solution 

1. Mix equal parts of Part A and Part B 

 Fast Green FCF Solution 

1. Dissolve 0.1g fast green FCFR in 1000mL dH20 

 1% Acetic Acid Solution 

1. Mix 10mL glacial acetic acid with 990mL dH20 

 0.1% Safranin O Solution 

1. Dissolve 1g Safranin O in 1000mL dH20 

Methods 

1. “taiŶ ǁith Weigeƌt’s iƌoŶ heŵatoǆǇliŶ working solution for 10 minutes 

2. Wash in running tap water for 10 minutes – take care not to run faucet open too far, 

pressure/agitation will cause samples to come off slide  

3. Stain with fast green (FCF) solution for 5 minutes 

4. Rinse quickly with 1% acetic acid solution for no more than 10 – 15 seconds (~4 dips) 

5. Stain in 0.1% safranin O solution for 25 minutes 

6. Dehydrate and clear with 95% ethanol, absolute ethanol and xylene, using 2 changes 

each, for 2 minutes each 
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Cleanup 

 Weigerts, Safranin O and Fast green are saved. Filter using funnel and filter paper back into their 

containers (weigerts must be placed in used container as it comes separated and is mixed to activate). 

Acetic acid, ethanol and xylene washes are disposed of in respective labeled waste containers. 

 

Tips 

 Filter and put away hematoxlyin at end of staining if you will not be staining the next day – it 

will degrade quickly otherwise and affect your staining!! 

 

 Replace acetic wash every other round of staining. 

Trouble shooting 

 If slides still have stain on them, plunge slide holder up and down during the acetic acid wash 

and ethanol/xylene clearings. 

 If samples are falling off, relax slides additional times before staining, review slicing methods – if 

slices are not smooth and uniform they come off easier. 

Weigerts solution once mixed will last approx. 3 months 

Results 

-GAGs: red 

-Nuclei: black 

-Cytoplasm: gray-green 

-Cartilage, mucin, mast cell granules: orange-red 

 

5.2.5 Live Dead Image Analysis Protocol  

 

Image J and Cell C steps can be performed independent of each other 

 

Image J 

 Open Image J 

o Desktop  ->   Fiji-win64 file  ->  Fiji.app  ->  Image J-win64.exe  -> Run 

 Calibration Image   

o Drag and drop from Computer  ->  Kate  ->  LiveDead  -> Sheep  -> Live dead 

calibration 

o Using straight line tool draw line on calibration image 

o Analyze  ->  Set scale  -> Type in known distance & unit length  -> Global  -> OK 

 Import Image   

o Drag and drop from Computer  ->  Kate  ->  LiveDead  -> Sheep  -> Specific File of 

interest 
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 Trim Image   

o Using freehand selection tool outline image (remove outer edge and synovium) 

o Edit  ->  Clear Outside   

o Flood Fill Tool  ->  click on white background  

 Save new image 

o File  ->  Save as  -> Tiff  -> label and save in appropriate location 

  

Cell C 

 Open Cell C 

o Desktop  -> Cell C  ->  cellc.exe   

 Remove save options 

o Save options  -> deselect both save options  

 Import Image   

o File  -> Open  -> Image for total cell count (Figure 1) 

o Computer  -> Kate  ->  LiveDead  -> Sheep  Dead  -> Specific File of interest (the 

trimmed file created in Image J) 

 Adjustments 

o Automatic intsity threshold (Figure 1) 

 Adjustthr – > adjust threshold bar  (adjust to match)  -> Ok 

o Automatic removal of over/undersized cells 

 Remove objects smaller than: 0 

 Remove objects larger than: 300 

o Divide cell clusters into single cells : 0.9 

o Cluster division algorithm: Cell intensity 

o Type of Image: Fluorescence microscopy 

 Analyze and Save Data   

o Click Analyze  

o “aǀe ͞Ŷuŵďeƌ of Đells ǀalue 

 Computer  -> Kate  ->  LiveDead  -> Sheep  -> Analysis -> Type in value 

where appropriate 
 

5.2.6 GAG Analysis Protocol  

 

Image J  

 Open Image J 

o Desktop  ->   Fiji-win64 file  ->  Fiji.app  ->  Image J-win64.exe  -> Run 

 Calibration Image   

o Drag and drop from Computer  ->  Kate  ->  GAG  ->  Sheep  -> Study of Interest  -

> Calibration bright field 

o Using straight line tool draw line on calibration image 

o Analyze  ->  Set scale  -> Type in known distance & unit length  -> Global  -> OK 

 Import Image   

o May need to stitch images -> see next step 
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o Drag and drop from Computer  ->  Kate  ->  GAG  ->  Sheep  -> Study of Interest  -

> Specific File of interest 

 Stitch Image  (two options use Mosaic J whenever possible if blurry then pairwise 

sitching) 

o Mosaic J: Plugins -> Stitching -> Mosaic J 

 File -> Open Image/Open Image Sequence  

 Click on images in lower bar to bring them into working plane -> Align 

images  

 File -> Save as - > file name_Full -> may have to enable global scale & 

disable messages   

o Pairwise stitching: Dƌag aŶd dƌop tǁo iŵages iŶto Fiji ;see ͞Iŵpoƌt Iŵage͟Ϳ 
 Plugins -> Stitching -> Pairwise stitching 

 Window will appear with two image titles -> Ok -> linear blending -> Ok -> 

stitched image appears 

 Image -> Type -> RGB -> RGB version appears -> File -> Save as -> file 

name_Full 

 Trim Image 

o Import filename_Full image if not already open  

o Using freehand selection tool outline image (remove outer synovium and 

background) 

o Edit  ->  Clear Outside   

o File -> save as -> file name_Full_Trimmed 

 

 Color Deconvelution 

o Import filename_Full_Trimmed image if not already open  

o Image -> Color -> Color Deconvelution 

o Color Deconvelution window will appear -> From ROI -> Ok 

o Ok -> select red stain -> Ok -> select blue stain -> Ok -> select backround stain 

o Delete image 3 -> Save image 2 as filename_Full_Trimmed_FG -> Save image 1 as 

filename_Full_Trimmed_SafO 

 

 Thresholing SafO image 

o Import filename_Full_Trimmed_SafO image if not already open  

o Image -> Adjust -> Threshold -> Adjust to match image -> Apply 

 

 Analyzing SafO image particles 

o Analyze -> Analyze Particles -> ͞Ϭ-IŶfiŶitǇ͟͟Ϭ-ϭ͟͟ŶothiŶg͟ -> OK 

o File -> save as -> file name_Results_SafO 

 

 Thresholing Full image 

o Import filename_Full_Trimmed image if not already open 

o Image -> Type -> 8Bit  

o Image -> Adjust -> Threshold -> Adjust to cover full image -> Apply 
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 Analyzing Full image particles 

o Analyze -> Analyze Particles -> ͞Ϭ-IŶfiŶitǇ͟͟Ϭ-ϭ͟͟ŶothiŶg͟ -> OK 

o File -> save as -> file name_Results  

 

Excell 

 OpeŶ eǆĐel files ;…Results aŶd ….Results_“afOͿ 
 Sum all areas (column B) 

 Add totals to master Excell file for ACLF ACLT GAG Results  

o Be sure to add to All working as well as corresponding individual sheet 
 

5.2.7 Nitric Oxide Assay Protocol 

Cayman Chemical Nitrate/Nitrite Colorimetric Assay Kit 

1. All tissue culture medium must be filtered before performing assay. 

a. Amicon Ultra – 0.5mL Centrifugal Filters 10,000 NMWL (10k) 

2. Reconstitute all reagents as directed by kit booklet. Storage and stability information can be 

found in booklet as well. (T drive: projects: STML: Finished Protocols: Assays: Cayman NO 

Assay.pdf) 

a. Nitrate/Nitrite Assay Buffer 

i. Dilute to 100 mL with UltraPure water 

b. Nitrate Reductase Enzyme Preparation 

i. Reconstitute with 1.2 mL Assay Buffer. Vortex. 

c. Nitrate Reductase Cofactors Preparation 

i. Reconstitute with 1.2 mL Assay Buffer. Vortex. 

d. Nitrate Standard 

i. Reconstitute with 1.0 mL Assay Buffer. Vortex. 

e. Nitrite Standard (typically not used) 

i. Reconstitute with 1.0 mL Assay Buffer. Vortex. 

f. Griess Reagents R1 and R2 

i. Ready for use 

 

3. Setting up the assay 

a. Example plate: 

i. S0 – Standard 0 uM 

ii. U1 – Unknown sample 1 
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  1 2 3 4 5 6 7 8 9 10 11 12 

A S0 S0 U1 U1 U9 U9 U17 U17 U25 U25 U33 U33 

B S1 S1 U2 U2 U10 U10 U18 U18 U26 U26 U34 U34 

C S2 S2 U3 U3 U11 U11 U19 U19 U27 U27 U35 U35 

D S3 S3 U4 U4 U12 U12 U20 U20 U28 U28 U36 U36 

E S4 S4 U5 U5 U13 U13 U21 U21 U29 U29 U37 U37 

F S5 S5 U6 U6 U14 U14 U22 U22 U30 U30 U38 U38 

G S6 S6 U7 U7 U15 U15 U23 U23 U31 U31 U39 U39 

H S7 S7 U8 U8 U16 U16 U24 U24 U32 U32 U40 U40 

 

 

4. Preparation of Nitrate Standard Curve 

a. If testing tissue culture media: Add 0.9 mL filtered unconditioned media to test tube.  

Add 0.1 mL of Nitrate standard. Vortex.  Stock standard is 200 uM.  To prepare standard 

curve, use the following table. 

Well 

Nitrate 

Standard (uL) Media (uL) 

A1, A2 0 80 

B1, B2 5 75 

C1, C2 10 70 

D1, D2 15 65 

E1, E2 20 60 

F1, F2 25 55 

G1, G2 30 50 

H1, H2 35 45 

 

5. Performing the assay 

a. Add up to 80 uL of sample to wells.  Final volume must be adjusted to 80 uL using Assay 

Buffer. 

b. Add 10 uL of Nitrate Reductase Cofactors Preparation to all wells. 

c. Add 10 uL of Nitrate Reductase Enzyme Preparation to all wells. 

d. Cover the plate and incubate at room temperature for 2 hours. 

e. Add 50 uL of Griess Reagent R1 to all wells. 

f. Add 50 uL of Griess Reagent R2 to all wells. 

g. Allow color to develop for 10 minutes at room temperature. 

h. Read the absorbance at 540 nm. 
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5.3 Raw Data 

 

5.3.1 Live/Dead 

Raw data from Live/Dead assay.   

W = 10% strain without P188 

X = 20% strain without P188 

Y = 10% strain with P188 

Z = 20% strain with P188 

1 Day 

       

  
LIVE DEAD TOTAL % LIVE % DEAD 

%Live 

Average 

W1 1R-LA 342 55 397 86 14 85 

W2 2R-MA 279 208 487 57 43 57 

W3 1L-LP 459 83 542 85 15 

 W4 3L-LA 168 39 207 81 19 81 

W1 1R-LA 310 150 460 67 33 67 

W2 1L-MA 222 111 333 67 33 

 W3 2R-MP 225 233 458 49 51 67 

W4 2L-LP 99 18 117 85 15 

 W5 3R-LA 249 43 292 85 15 85 

        

        X1 1R-LP 68 99 167 41 59 44 

X2 2R-MP 444 152 596 74 26 56 

X3 2L-MA 180 234 414 43 57 

 X4 1L-LA 229 258 487 47 53 

 X5 3L-MP 725 484 1209 60 40 60 

X6 2L-MP 323 304 627 52 48 

 X1 1R-LP 134 162 296 45 55 45 

X3 2R-MA 325 173 498 65 35 57 

X4 2L-MP 170 174 344 49 51 

 X5 3R-LP 377 306 683 55 45 55 

        

        Y1 1R-MP 336 115 451 75 25 75 

Y2 2R-LP 322 246 568 57 43 63 

Y3 2L-LP 334 153 487 69 31 

 Y4 3R-MA 327 97 424 77 23 77 

Y1 1R-MP 151 129 280 54 46 69 
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Y2 1L-LP 338 64 402 84 16 

 Y3 2R-LA 244 198 442 55 45 61 

Y4 2L-MA 387 193 580 67 33 

 Y5 3R-MP 246 242 488 50 50 66 

Y6 3R-LA 157 34 191 82 18 

 

        

        Z1 1R-MA 233 122 355 66 34 60 

Z2 2R-LA 239 232 471 51 49 60 

Z3 2L-LP 118 50 168 70 30 

 Z4 1L-MP 144 120 264 55 45 

 Z5 3R-LA 417 319 736 57 43 63 

Z6 3L-MP 382 173 555 69 31 

 Z1 1R-MA 285 212 497 57 43 61 

Z2 1L-MP 381 207 588 65 35 

 Z3 2R-LP 153 115 268 57 43 56 

Z4 2L-LA 695 560 1255 55 45 

 Z5 3R-MA 352 219 571 62 38 57 

Z6 3R-LP 341 302 643 53 47 

  

 

7 Day 

       

        

  
LIVE DEAD TOTAL % LIVE % DEAD 

%Live 

Average 

W1 1R-LA 431 262 693 62 38 64 

W2 1L-LP 286 146 432 66 34 

 W3 2L-MP 325 242 567 57 43 57 

W4 3R-LA 323 271 594 54 46 54 

W1 1R-LA 218 73 291 75 25 72 

W2 1L-LP 380 171 551 69 31 

 W3 2R-MP 423 270 693 61 39 66 

W4 2L-LP 459 194 653 70 30 

 W5 3R-MP 269 195 464 58 42 72 

W6 3L-LA 517 79 596 87 13 

 

        

        X1 1R-LP 485 244 729 67 33 62 

X2 1L-MP 224 162 386 58 42 

 X3 2R-LA 318 279 597 53 47 53 
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X4 3R-LP 489 366 855 57 43 57 

X1 1R-LP 404 225 629 64 36 64 

X2 1L-MP 361 199 560 64 36 

 X3 2R-MA 234 225 459 51 49 51 

X4 2L-LA 270 261 531 51 49 

 

        

        Y1 1R-MP 254 238 492 52 48 52 

Y2 2R-LP 111 209 320 35 65 61 

Y3 2L-LP 513 72 585 88 12 

 Y4 3L-LA 382 274 656 58 42 58 

Y1 1R-MP 381 120 501 76 24 76 

Y2 2R-LA 200 181 381 52 48 53 

Y3 2L-MA 428 377 805 53 47 

 Y4 3R-LP 190 98 288 66 34 71 

Y5 3L-LP 220 88 308 71 29 

 Y6 3L-MP 352 105 457 77 23 

 

        

        Z1 1L-LA 285 172 457 62 38 62 

Z2 2R-MA 301 128 429 70 30 70 

Z3 3R-MP 344 322 666 52 48 52 

Z1 1L-LA 332 168 500 66 34 66 

Z2 2R-LP 519 270 789 66 34 68 

Z3 2L-MA 228 100 328 70 30 

 Z4 3R-LA 198 121 319 62 38 62 

 

5.5.2 GAG Coverage 

Raw data from GAG histology. 

1 Day 

     

  
Saf O Total % GAG 

%GAG  

Average 

W1 1R-LA * * * 

 W2 2R-MA 2316694 2908034 80 80 

W3 1L-LP 2572001 5693248 45 45 

W4 3L-LA 3256946 5291833 62 62 

W1 1R-LA 4142789 6533091 63 62 

W2 1L-MA 4498399 7529580 60 

 W3 2R-MP * * 

  W4 2L-LP 3266712 5177078 63 63 
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W5 3R-LA 3313606 4586028 72 41 

W6 3L-MP 578599 5861466 10 

 

      X1 1R-LP 2971834 6623793 45 28 

X2 2R-MP 3428056 7995592 43 54 

X3 2L-MA 1911914 3591567 53 

 X4 1L-LA 882018 7860699 11 

 X5 3L-LP * * * 

 X6 2L-MP 5951751 8915482 67 

 X1 1R-LP 2781996 4843451 57 57 

X2 2R-MA 6814212 8165306 83 60 

X3 2L-MP 2482734 6828284 36 

 X4 3R-LP 4041738 8885089 45 45 

      Y1 1R-MP * * * 

 Y2 2R-LP 6190072 8081194 77 79 

Y3 2L-LA 6561506 8152479 80 

 Y4 3R-MA 4561329 7059787 65 65 

Y1 1R-MP 4508479 7609726 59 56 

Y2 1L-LP 3845740 7411310 52 

 Y3 2R-LA 4914811 7900409 62 56 

Y4 2L-MA 2694229 5354238 50 

 Y5 3R-MP 1296967 6258116 21 39 

Y6 3R-LA 3843442 6700700 57 

 

      Z1 1R-MA 7768579 8377710 93 73 

Z2 2R-LA 4458572 6574291 68 71 

Z3 2L-LP 5436170 7407971 73 

 Z4 1L-MP 3894156 7229441 54 

 Z5 3R-LA 4035249 7008122 58 57 

Z6 3L-MP 3950685 6988681 57 

 Z1 1R-MA 4972466 8064818 62 62 

Z2 1L-MP 4302079 6818332 63 

 Z3 2R-LP 1510598 6027659 25 33 

Z4 2L-LA 2546683 6194560 41 

 Z5 3R-MA 4140013 7084283 58 58 

Z6 3R-LP 4016774 6865446 59 

 * unable to cut good slice to analyze % GAG 

7 Day 

     

  
Saf O Total % GAG 

%GAG  

Average 
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W1 1R-LA 3104995 6300035 49 68 

W2 1L-LP 5659351 6571000 86 

 W3 2L-MP 6183631 10051385 62 62 

W4 3R-LA 6391754 8044164 79 79 

W1 1R-LA 4563623 7405683 62 62 

W2 1L-LP 3676339 5814371 63 

 W3 2R-MP 422062 6644426 6 14 

W4 2L-LP 1421076 6491715 22 

 W5 3R-MP 3519617 7477378 47 65 

W6 3L-LA 4786495 5789946 83 

 

      X1 1R-LP 5462997 8333880 66 56 

X2 1L-MP 4178086 8907433 47 

 X3 2L-LP * * 

  X4 3L-LA 4688611 7976832 59 59 

X1 1R-LP 2963813 4239107 70 62 

X2 1L-MP 2288830 4302581 53 

 X3 2R-MA 4504123 6599514 68 68 

X4 2L-LA 3318481 4927888 67 

 

      Y1 1L-LA 3725467 8308863 45 45 

Y2 2R-MA 1907331 8687173 22 28 

Y3 3R-MP 2472334 7401190 33 52 

Y4 3L-LP 5704759 8126342 70 

 Y1 1R-MP 3450131 8380607 41 41 

Y2 2R-LA 5440470 8681445 63 45 

Y3 2L-MA 1968154 7282072 27 

 Y4 3R-LP 3148512 5517303 57 53 

Y5 3L-LP 4867643 6950845 70 

 Y6 3L-MP 2190621 7060691 31 

 

      Z1 1L-LA 6495262 7482301 87 87 

Z2 2R-MA 4104974 8068416 51 51 

Z3 3R-MP 5377354 8415631 64 56 

Z4 3L-LP 3981833 8156092 49 

 Z1 1L-LA 4523549 6019009 75 75 

Z2 2R-LP 2867141 5960211 48 36 

Z3 2L-MA 1329560 5508321 24 

 Z4 3R-LA 4287649 4935224 87 87 

* unable to cut good slice to analyze % GAG 
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5.3.3 NO Assay 

Standard Curve 

 

 

Raw Data from NO Assay. 

1 Day 

    

Sample Pig Absorbance 

Concentration 

(uM) 

Average 

Concentration 

W1 1R-LA 0.2735 8.25 8.60 

W2 2R-MA 0.2535 7.503731343 7.50 

W3 1L-LP 0.292 8.940298507 

 W4 3L-LA 0.274 8.268656716 8.27 

W1 1R-LA 0.4825 16.04850746 11.58 

W2 1L-MA 0.243 7.111940299 

 W3 2R-MP 0.291 8.902985075 8.11 

W4 2L-LP 0.2485 7.317164179 

 W5 3R-LA 0.33 10.35820896 9.63 

W6 3L-MP 0.291 8.902985075   

X1 1R-LP 0.248 7.298507463 8.64 

X2 2R-MP 0.2395 6.981343284 8.62 

X3 2L-MA 0.2715 8.175373134 

 X4 1L-LA 0.32 9.985074627 

 X5 3L-LP 0.336 10.58208955 10.58 

X6 2L-MP 0.3395 10.71268657 

 X1 1R-LP 0.2775 8.399253731 8.40 

X2 2R-MA 0.2725 8.212686567 8.69 

y = 0.0268x + 0.0524

R² = 0.9993
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X3 2L-MP 0.298 9.164179104 

 X4 3R-LP 0.325 10.17164179 10.17 

Y1 1R-MP 0.208 5.805970149 5.81 

Y2 2R-LP 0.198 5.432835821 5.68 

Y3 2L-LA 0.2115 5.936567164 

 Y4 3R-MA 0.207 5.768656716 5.77 

Y1 1R-MP 0.28 8.492537313 7.99 

Y2 1L-LP 0.253 7.485074627 

 Y3 2R-LA 0.238 6.925373134 8.42 

Y4 2L-MA 0.318 9.910447761 

 Y5 3R-MP 0.274 8.268656716 7.75 

Y6 3R-LA 0.246 7.223880597   

Z1 1R-MA 0.186 4.985074627 4.73 

Z2 2R-LA 0.1965 5.376865672 5.11 

Z3 2L-LP 0.182 4.835820896 

 Z4 1L-MP 0.1725 4.481343284 

 Z5 3R-LA 0.209 5.843283582 6.06 

Z6 3L-MP 0.2205 6.27238806 

 Z1 1R-MA 0.2905 8.884328358 8.09 

Z2 1L-MP 0.248 7.298507463 

 Z3 2R-LP 0.2705 8.138059701 8.41 

Z4 2L-LA 0.285 8.679104478 

 Z5 3R-MA 0.2475 7.279850746 7.90 

Z6 3R-LP 0.2805 8.51119403 

  

7 Day 

    

Sample Pig Absorbance 

Concentration 

(uM) 

Average 

Concentration 

W1 1R-LA 0.26 7.746269 7.80 

W2 1L-LP 0.263 7.858209 

 W3 2L-MP 0.251 7.410448 7.41 

W4 3R-LA 0.2805 8.511194 8.51 

W1 1R-LA 0.357 11.36567 9.47 

W2 1L-LP 0.2555 7.578358 

 W3 2R-MP 0.2445 7.16791 7.07 

W4 2L-LP 0.239 6.962687 

 W5 3R-MP 0.227 6.514925 7.70 

W6 3L-LA 0.2905 8.884328   

X1 1R-LP 0.2935 8.996269 8.75 

X2 1L-MP 0.2805 8.511194 

 X3 2L-LP 0.2735 8.25 8.25 
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X4 3L-LA 0.255 7.559701 7.56 

X1 1R-LP 0.281 8.529851 8.18 

X2 1L-MP 0.2625 7.839552 

 X3 2R-MA 0.235 6.813433 7.01 

X4 2L-LA 0.2455 7.205224   

Y1 1L-LA 0.2675 8.026119 8.03 

Y2 2R-MA 0.2305 6.645522 6.65 

Y3 3R-MP 0.2535 7.503731 8.36 

Y4 3L-LP 0.2995 9.220149 

 Y1 1R-MP 0.248 7.298507 7.30 

Y2 2R-LA 0.2335 6.757463 7.28 

Y3 2L-MA 0.2615 7.802239 

 Y4 3R-LP 0.2245 6.421642 6.57 

Y5 3L-LP 0.231 6.664179 

 Y6 3L-MP 0.23 6.626866   

Z1 1L-LA 0.2735 8.25 8.25 

Z2 2R-MA 0.3095 9.593284 9.59 

Z3 3R-MP 0.3075 9.518657 9.29 

Z4 3L-LP 0.2955 9.070896 

 Z1 1L-LA 0.2905 8.884328 8.88 

Z2 2R-LP 0.24 7 7.19 

Z3 2L-MA 0.25 7.373134 

 Z4 3R-LA 0.2425 7.093284 7.09 

 

5.3.4 Mechanical Data 

Values foƌ ͞a͟ ĐoeffiĐieŶt 

7 Day 

    

 
10 no P188 10 P188 20 no P188 20 P188 

Day 1 74.2 40.89 201.5 328.1 

Day 2 122.6 156.7 202.6 315.9 

Day 3 19.27 19.27 262.2 337 

Day 4 48.89 31.67 253.2 252.6 

Day 5 29.74 26.22 223.5 361.4 

Day 6 70.73 954.9 136.2 451 

Day 7 52.23 24.85 247 252.1 
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Values foƌ ͞ď͟ ĐoeffiĐieŶt 

7 Day 

    

 
10 no P188 10 P188 20 no P188 20 P188 

Day 1 -0.4427 -0.2329 -0.3008 -0.2572 

Day 2 -0.295 -0.06834 -0.2636 -0.2582 

Day 3 -0.2259 -0.2259 -0.2275 -0.1842 

Day 4 -0.1859 -0.29 -0.1336 -0.3042 

Day 5 -0.3316 -0.2436 -0.304 -0.2393 

Day 6 -0.2711 -0.00352 -0.3534 -0.1755 

Day 7 -0.2482 -0.2377 -0.2051 -0.1774 

 

Values foƌ ͞Đ͟ ĐoeffiĐieŶt 

7 Day 

    

 
10 no P188 10 P188 20 no P188 20 P188 

Day 1 36.47 6.872 24.58 13.57 

Day 2 13.41 -82.27 16.81 36.88 

Day 3 3.841 3.841 9.349 -25.03 

Day 4 4.655 7.67 -51.84 26.47 

Day 5 12.45 6.767 12.16 7.537 

Day 6 14.57 -918.2 32.11 -42.08 

Day 7 2.661 4.616 -4.109 -12.41 

 


